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Školící materiály pro začátečníky 

Factory Design Suite Ultimate 2013 
 

Tyto školící materiály jsou určeny pro uživatele, kteří mají základní znalosti aplikace AutoCAD. 

Cvičení Vás provedou možnými postupy napříč aplikacemi Factory Design Suite Ultimate 2013. 

Poznámka k českému překladu: Uvedené příkazy jsou pro lokalizované produkty vždy uvedeny ve 

formátu: EN příkaz/CZ příkaz, např: OPEN/OTEVŘI. Příkazy u nelokalizovaných produktů jsou 

uvedeny pouze EN. 
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1 Obecně 

Všechny složky a soubory použité v následujících cvičeních vychází z kořenové složky. Ve cvičeních v 

tomto dokumentu je definována kořenová složka jako C:\FDS-ROOT. Sami si však můžete zvolit její 

umístění a pojmenování. 

Jakmile vytvoříte kořenovou složku, rozbalte do ní obsah souboru FDS-ROOT.zip. 

2 Tvorba prostředí v Inventoru

1. Otevřete aplikaci Autodesk Inventor. 

2. Otevřete dialogové okno Projects/Projekty. 
Ribbon/Pás karet: Get started/Začínáme > 
Factory Launch/Spuštění výrobní linky. 

 

3. Pro vytvoření nového projektu klikněte na 
tlačítko New/Nová. 

4. Zvolte možnost New Single User 
Project/Nový jednouživatelský projekt a 
poté klikněte na Next/Další. 

 

5. Potvrďte FDS Training jako název projektu a 
pro jeho uložení zvolte složku <FDS-ROOT. 

 

6. Klekněte na Finish/Dokončit. 

7. V dialogovém okně Projects/Projekty zvolte 
možnost Libraries/Knihovny. 

Vytvořte novou knihovnu použitím tlačítka 
Add new path/Přidat novou cestu (symbol 
křížku). 

Zvolte adresář  <FDS-ROOT>/Training 
Assets jako složku knihovny a knihovnu 
pojmenujte jako Training. 

 

8. Klikněte na tlačítko Save/Uložit. Pro 
uzavření dialogového okna 
Projects/Projekty klikněte na Done/Hotovo. 
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3 Tvorba prostředí v AutoCADu Architecture

1. Otevřete AutoCAD Architecture. 

2. V průzkumníku Windows otevřete soubor 
<FDS-ROOT>/Templates/FDS 
Training.dwt. 

3. V aplikaci AutoCAD Architecture otevřete 
dialogové okno Options/Možnosti. 
Application Menu/Menu aplikace> 
Options/Možnosti 

4. Klikněte na kartu Factory. 

Pomocí tlačítka Transportation 
Defaults/Výchozí nastavení přepravy 
otevřete okno Transportation 
Defaults/Výchozí nastavení přepravy. 

Pro vytvoření nového Transportation 
Type/Typu přepravy použijte tlačítko 
Add/Přidat. 

Pojmenujte nový Typ přepravy jako 
Electric platform carriage a zadejte 
následující hodnoty: 

Property Value Units 

Travel Speed/ 
Rychlost pohybu 

140 m/min 

Cost Rate/ 
Nákladová sazba 

8 /Hour 
/hod 

Load time/ 
Doba nakládání 

0.5 min 

Unloading time/ 
Čas vykládání 

0.5 min 

Pro potvrzení změn klikněte na OK. 

5. Klikněte na kartu Factory 
Assets/Komponenty výrobní linky. 

V poli Libraries/Knihovny klikněte na 
tlačítko Browse/Procházet. 

Otevřete adresář  <FDS-ROOT> a vyberte 
soubor FDS Training.ipj. 

Klikněte na OK a zavřete dialogové okno 
Options/Možnosti. 

6. Uložte soubor jako šablonu s názvem FDS 
Training.dwt. 
Application Menu/Menu aplikace> Save 
as/Uložit jako > Drawing 
Templates/Výkresová šablona 

 

V dialogovém okně Template 
Options/Možnosti šablony, klikněte na 
tlačítko OK. 

7. Znovu otevřete dialogové okno 
Options/Možnosti. 

8. Klikněte na kartu Files/Soubory a 
otevřete Template Settings/Nastavení 
šablony. 
Template Settings/Nastavení šablony > 
Default Template File Name for 
QNEW/Výchozí název souboru šablony 
pro RNOVÝ  

 

Dvojklikem na černou šipku otevřete   
dialogové okno pro výběr nové výchozí 
šablony.  

Zvolte soubor FDS Training.dwt. 

Pro potvrzení provedených změn klikněte 
na tlačítko OK a zavřete dialogové okno 
Options/Možnosti. 

9. Na stavovém řádku ve spodní části 
grafického okna klikněte pravým 
tlačítkem myši na tlačítko DYN / Dynamic 
Input/Dynamické zadání. 

Z menu zvolte možnost 
Settings/Nastavení. 
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V dialogovém okně aktivujte všechny 
možnosti na kartě Dynamic 
Input/Dynamické zadání.  

V poli Pointer Input/Zadání ukazatele 
klikněte na tlačítko Settings/Nastavení. 

 

V dialogovém okně klikněte na formát 
Relative coordinates/Relativní 
souřadnice. 

Stisknutím klávesy OK potvrďte 
provedené změny. 

 

10. Zavřete dialogové okno pomocí tlačítka 
OK. 

11. Zavřete výkres. Šablonu znovu již 
neukládejte.  
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4 Vložení výkresu rozmístění jako reference

1. Otevřete AutoCAD Architecture. 

2. Vytvořte nový výkres. 
Quick Access Toolbar/Panel nástrojů rychlý 
přístup > New/Nový 

 

Výkres bude vytvořen automaticky na 
základě šablony FDS Training.dwt. 

3. Otevřete External References 
Manager/Externí reference. 
Ribbon/Pás karet: Insert/Vložit > Reference 
> Dialog Starter/Další 

 

Klikněte na Attach DWG/Připojit DWG. 

 

Zvolte soubor <FDS-ROOT>/Layout/ 
ExteriorSite.dwg. 

Vložte výkres do souřadnic 0,0,0 se 
zvolenou možností Overlay/Podložit. 

 

Zavřete  External References 
Manager/Externí reference. 

4. Uložte výkres jako <FDS-
Root>\Layout\Building. 
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5 Vytvoření sloupové osnovy

1. Otevřete Design Tool Palette/Nástroje pro 
navrhování. 
Ribbon/Pás karet: Home/Výchozí > 
Build/Sestavit > Tools Flyout/Nástroje> 
Design Tools/Nástroje pro navrhování.  

 

Na panelu nástrojů Design/Návrh zvolte typ 
Column Grid/Sloupová osnova. 

 

V okně vlastností nastavte Bay size/Velikost 
rozteče na 9000 x 9000. 

 

Umístěte sloupovou osnovu na souřadnice 
0,0,0 s nulovým natočením. 

2. Vyberte sloupovou osnovu. 

Zvolte pravý horní bod a roztáhněte mřížku 
ve směru x na 7 polí a ve směru y na 4 pole. 
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3. V okně vlastností na ose x změňte Layout 
type/Typ rozvržení na Manual/Ručně. 

 

Uchopte pravý koncový bod na ose y a 
posuňte jej o 4000 jednotek doleva. 

 
 

4. Spusťte příkaz Label/Popisek. 
Ribbon/Pás karet: Column Grid/Sloupová 
osnova > Label/Popisek > Label/Popisek 

 

Na kartě X – Labeling/Popisky X označte 
osu x písmeny A, B, C, …a zvolte možnost 
Bottom/Dole. 

 

Na kartě Y – Labeling/Popisky Y označte 
osu y čísly 1, 2, 3, …a zvolte možnost 
Left/Vlevo. 

 

K potvrzení klikněte na OK. 

 

5. Uložte výkres jako <FDS-
Root>\Layout\Building. 
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6 Vytvoření sloupů

1. Otevřete Structural Member 
Catalog/Katalog konstrukčních prvků. 
Ribbon/Pás karet: Manage/Správa > Pull 
Down Menu/Rozbalovací menu: Style & 
Display/Styl a zobrazení > Structural 
Member Catalog/Katalog konstrukčních 
prvků 

 

V prohlížeči vyberte IPBI-Shapes/Tvary IPBI. 
Metric/Metrické > Steel/Ocel > DIN > I-
Shaped/Tvar I > IPBI-Shapes/Tvary IPBI 

 

Dvojklikem zvolte konstrukční prvek modelu 
IPBI 300. 

Potvrďte navržené označení (IPBI 300) a 
klikněte na OK. 

2. Zopakujte postup pro konstrukční prvek 
modelu IPBI 400 a zavřete Structural 
Member Catalog/Katalog konstrukčních 
prvků. 

3. Otevřete panel nástrojů Design/Návrh. 

Z panelu nástrojů Design/Návrh zvolte typ 
Column/Sloup. 

 

V okně vlastností změnte column style/Styl 
na IPBI 400. 
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Zadejte patky sloupů do souřadnic bodů 
sloupové osnovy 1/0, 1/2 a 1/4.  

 

4. Zvolte spodní sloup. V okně vlastností u něj 
změňte Logical length/Logická délka na 
8000 a justification/zarovnat na Bottom 
Center/dole ve středu. 

 

5. Zvolte horní sloup. V okně vlastností u něj 
změňte Logical length/Logická délka na 
8000 a justification/ zarovnat na top 
center/nahoře ve středu. 

6. Použijte View Controls/ovládací prvky pro 
pohled a přepněte na Left/levý pohled. 

 

7. Zvolte příkaz Line/Úsečka. 
Ribbon/Pás karet: Home/Výchozí > 
Draw/Kreslit > Line/Úsečka 

 

Jako výchozí bod zvolte vrchní levý okraj 
levého sloupu. 

Z tohoto bodu veďte přímku o délce 20000 
pod úhlem 10 stupňů. 

 

8. Znovu zvolte příkaz Line/ Úsečka . 

Jako výchozí bod zvolte vrchní pravý okraj 
pravého sloupu. 

Z tohoto bodu veďte přímku o délce 20000 
pod úhlem 170 stupňů. 

 

9. Otevřete příkaz Fillet/Zaoblit. 
Ribbon/Pás karet: Home/Výchozí > 
Modify/Upravit > Chamfer and Fillet 
Flyout/Nabídka zaoblit a zkosit > 
Fillet/Zaoblit 
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Zvolte možnost Radius/Poloměr a potvrďte 
0 jako novou hodnotu. 

Zvolte obě úsečky pro automatické 
zaoblování. 

10. Použijte View Controls/ovládací prvky pro 
pohled a změňte pohled na SW 
Isometric/SW Iso. 

 

11. Otevřete příkaz Move/Posun. 
Ribbon/Pás karet: Home/Výchozí > 
Modify/Upravit > Move/Posun 

 

Zvolte obě úsečky a umístěte je tak, aby 
byly ve středu vnějších okrajů sloupu. 

 

12. Otevřete panel nástrojů Design/Návrh a 
dvojklikem zvolte typ Beam/Trám. 

 

Zvolte možnost menu Apply Tool 
Properties/Použít vlastnosti nástroje na a v 
něm možnost Linework/Skica. 

 

Zvolte úsečky, které byly vytvořeny, a 
stisknutím klávesy [ENTER] výběr potvrďte. 

V následujícím dialogovém okně zvolte 
možnost Erase Layout Geometry/Odstranit 
geometrii rozvržení a pro potvrzení vložení 
klikněte na OK. 
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V okně vlastností zvolených trámů změnte 
style/styl na IPBI 300, roll/Natočení na 0 a 
justification/zarovnání na top 
center/nahoře ve středu. 

 

13. Použijte View Controls/ovládací prvky pro 
pohled a přepněte pohled na Left/Levý. 

14. Vyberte levý trám a spusťte příkaz 
Add Trim Plane/Přidat rovinu oříznutí. 
Ribbon/Pás karet: Structural 
Member/Konstrukční prvek > 
Modify/Upravit > Add Trim Planes/Přidat 
rovinu oříznutí 

 

Jako rovinu ořezu zvolte vnější okraj levého 
sloupu. 

15. Vyberte levý sloup a znovu spusťte příkaz 
Add Trim Plane/Přidat rovinu oříznutí. 

 

Jako rovinu ořezu zvolte vrchní okraj levého 
trámu. 

 

16. Otevřete příkaz Edit Trim Planes/Upravit 
roviny oříznutí. 
Ribbon/Pás karet: Structural 
Member/Konstrukční prvek > 
Modify/Upravit > Edit Trim Planes/Upravit 
roviny oříznutí 

 

Táhněte zvolenou ořezovou rovinu pomocí  
středového uchopovacího bodu na horní 
okraj levého trámu. 

 

17. Zopakujte postup pro pravou stranu. 
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18. Zvolte levý trám. 

Spusťte příkaz Miter/Začistit styky. 
Ribbon/Pás karet: Structural 
Member/Konstrukční prvek > 
Modify/Upravit > Miter/Začistit styky 

 

Zvolte pravý trám jako druhý konstrukční 
prvek k provedení příkazu.  

 

19. Zvolte středový sloup. 

Táhnutím horní středové šipky rozšiřte 
sloup ke spodnímu okraji střešní konstukce.  

 

20. Otevřete příkaz Add Trim Plane. 

Jako rovinu ořezu zvolte spodní okraj levého 
trámu. 

21. Otevřete příkaz Trim Planes/Roviny 
oříznutí. 
Ribbon/Pás karet: Structural 
Member/Konstrukční prvek > 
Modify/Upravit > Trim Planes/Roviny 
oříznutí 

 

Z panelu Trim Planes/Roviny oříznutí 
vyberte rovinu ořezu, která již existuje, a 
pomocí prostředního tlačítka vpravo ji 
zkopírujte. 

 

U zkopírované roviny ořezu změňte úhel 
otočení (Y) na 10 stupňů. Pro potvrzení 
změn klikněte na OK. 

 

 

22. Použijte View Controls/ovládací prvky pro 
pohled a přepněte pohled na  SW 
Isometric/SW Iso. 

23. Zvolte všech pět konstrukčních prvků. 

Otevřete příkaz Copy/Kopírovat. 
Ribbon/Pás karet: Home/Výchozí > 
Modify/Upravit > Copy/Kopírovat 

 

Zvolte vhodný počátek sloupové osnovy a 
umístěte sloupy podél osy x na všech osách 
y. 
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24. Použijte View Controls/ovládací prvky pro 
pohled, přepněte pohled na TOP/Horní. 

 

25. Zvolte sloup umístěný v sloupové osnově v 
bodě A0. 

V okně vlastností změňte 
Justification/zarovnání na Bottom 
left/Dole ve středu. 

 

26. Zvolte sloup umístěný v sloupové osnově v 
bodě A5. 

V okně vlastností změňte 
Justification/Zarovnání na Top left/Nahoře 
vlevo. 

27. Zvolte sloup umístěný ve sloupové osnově v 
bodě A3. 

V okně vlastností změňte 
Justification/Zarovnání na Middle 
left/Uprostřed vlevo. 

28. Zvolte spodní ze dvou trámů umístěných na 
ose A. 

V okně vlastností změňte 
Justification/Zarovnání na Top 
right/Nahoře vpravo. 

29. Zvolte horní ze dvou trámů umístěných na 
ose A. 

V okně vlastností změňte 
Justification/Zarovnání na Top left/Nahoře 
vlevo. 

 

 

30. Zopakujte výše uvedený postup v 
obráceném pořadí na druhém konci budovy 
(osa H).  

31. Uložte výkres jako <FDS-
ROOT>\Layout\Building.dwg. 
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7 Vytvoření zdí

1. Zvolte sloupovou osnovu. 

Spusťte příkaz Isolate Objects/Izolovat 
objekty. 
Ribbon/Pás karet: Column Grid/Sloupová 
osnova > General/Obecné > Isolate Objects 
Flyout/nabídka izolovat objekty> Isolate 
Objects/izolovat objekty.  

 

2. Otevřete panel nástrojů Design/Návrh. 

Na kartě Walls/Stěny klikněte na More 
Wall Tools/Více nástrojů stěn. 

 

Ve vyhledávacím okně zadejte CMU-X a pro 
potvrzení stiskněte GO/Přejít. 

 

Stiskněte a držte kurzor na modré ikoně 
vedle styku zdi CMU-X a přetáhněte ji do 
panelu nástrojů Walls/Stěny.   

 

Na panelu nástrojů Walls/Stěny zvolte typ 
CMU-X. 

 

V okně vlastností změňte šířku na 200 a 
základní výšku na 8000. 
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Proti směru hodinových ručiček vyberte 
čtyři rohové body. 

 

Po zvolení horního levého rohového bodu 
klikněte pravým tlačítkem myši uvnitř 
modelového pole a zvolte možnost 
Close/Uzavřít. 

 

3. Uložte výkres jako   

<FDS-ROOT>\Layout\Building.dwg. 
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8 Vytvoření střešní konstrukce

1. Otevřete panel nástrojů Design/Návrh a 
zvolte typ Roof/Střecha. 

 

Na panelu nástrojů změnte Edge 
cut/Vyjmutí hrany na možnost 
Plumb/Svisle, Overhang/Přesah na 400, 
Plate height/Výška uložení desky na 8000 a 
Slope/Sklon na 10 stupňů. 

 

Proti směru hodinových ručiček vyberte 
čtyři rohové body. 

Pro potvrzení stiskněte [ENTER]. 

2. Zvolte střešní konstukci. 

Zvolte bod úchopu na levém konci hřebenu 
střechy a táhněte jím na levý okraj střechy. 

 

3. Opakujte tento postup pro pravou stranu. 

Pravým tlačítkem myši otevřete kontextové 
menu.  

4. Zvolte možnost Isolate Objects/Izolovat 
objekty > End Object Isolation/Ukončit 
izolaci objektu. 

 

5. Užitím View Controls/ovládací prvky pro 
pohled změňte pohled na SW Isometric/SW 
Iso. 

6. Zvolte levou štítovou zeď.  

Otevřete příkaz Modify Roof Line. 
Ribbon/Pás karet: Wall/Stěna > 
Modify/Upravit > Roof/Floor Line 
Flyout/Zozbalovací menu Linie 
střechy/Podlaží > Modify Roof Line/Upravit 
horní hranu 
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Z menu Options/Možnosti zvolte možnost 
Auto project/Auto promítání. 

 

Zvolte objekt střechy jako referenční objekt 
a pro potvrzení výběru stiskněte [ENTER]. 

7. Zopakujte tento postup pro protilehlou 
šťítovou zeď.   

8. Použijte View Controls/ovládací prvky pro 
pohled a přepněte na Left/levý pohled. 

9. Zvolte levou šťítovou zeď. 

 

Otevřete příkaz Add Interference/Přidat. 
Ribbon/Pás karet: Wall/Stěna > 
Modify/Upravit > Interference 
Flyout/Rozbalovací nabídka kolize > 
Add/Přidat 

 

 Zvolte objekt střechy jako interferenční  
objekt.    

Stisknutím tlačítka [ENTER] potvrďte výběr. 

 V kontextovém menu vyberte 
Subtractive/Odečítání jako interferenční 
typ. Střecha nyní překrývá přední zeď. 

 

10. Dvakrát zopakujte postup na stejném 
štítovém průčelí za účelem překrytí zadní a 
boční zdi. 

 

11. Zopakujte krok 10 pro pravé štítové průčelí. 

12. Uložte výkres jako <FDS-
ROOT>\Layout\Building.dwg. 
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9 Vytvoření chodeb

1. Otevřete Layer Properties 
Manager/Správce vlastností hladiny. 
Ribbon/Pás karet: Home/Výchozí > 
Layer/Hladiny > Layer Properties/Vlastnosti 
hladiny 

 

2. Vytvořte novou vrtvu pomocí tlačítka New 
Layer/Nová hladina. 

 

Pojmenujte vrstvu jako A_Aisles a stanovte 
pro ni barvu 252. 

Pomocí tlačítka Current/Nastavit aktuální 
vrstvu nastavte jako aktuální. 

 

3. Zvolte všechny hladiny s výjimkou aktuální 
(A_Aisles), Xref a výchozí (0) a zmrazte je. 

 

4. Použitím View Controls/ovládací prvky pro 
pohled změňte pohled na Top/Horní. 

Otevřete příkaz Polyline/Křivka. 
Ribbon/Pás karet: Home/Výchozí > 
Draw/Kreslit > Line Flyout/Rozbalovací 
nabídka úsečka > Polyline/Křivka  

 

Táhněte síť chodeb jako uzavřenou křivku v 
budově /viz obrázek dole/. Výchozím 
bodem sítě chodeb zvolte levou stranu 
levého spodního vstupu do budovy.  
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5. Otevřete příkaz Chamfer/Zkosit. 
Ribbon/Pás karet: Home/Výchozí > 
Modify/Upravit > Chamfer and Fillet 
Flyout/Rozbalovací nabídka Zaoblit > 
Chamfer/Zkosit 

 

Pomocí klávesy [ŠIPKA DOLŮ] otevřete 
menu Options/možnosti a zvolte možnost 
Distance/Vzdálenost. 

 

Nastavte hodnotu na 1000 pro první a 
druhou vzdálenost. Pro potvrzení stisknete 
[ENTER]. 

Zvolte dvě sousedící úsečky sítě chodeb pro 
sražení hrany. 

6. Zopakujte postup pro zbývající vnitřní rohy 
sítě chodeb dle obrázku. 
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7. Otevřete kontextové menu kliknutím 
pravým tlačítkem na panel záložek pásu 
karet. 

Přidejte kartu Solids/Tělesa. 
Show Tabs/Zobrazit karty > Solids/Tělesa 

 

8. Otevřete příkaz Extrusion/Vytažení. 
Ribbon/Pás karet: Solids/Tělesa > 
Modeling/Modelování > Solid Creation 
Flyout/Rozbalovací nabídka Vytažení > 
Extrude/Vytažení.  

 

Zvolte síť chodeb a stiskněte [ENTER]. 

Pro výšku vysunutí nastavte 10 a stiskněte 
[ENTER]. 

9. Otevřete Layer Properties 
Manager/Správce vlastností hladiny. 

Zvolte všechny hladiny a rozmrazte je. 

10. Uložte výkres jako <FDS-
ROOT>\Layout\Building.dwg. 
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10 Vytvoření otvorů

1. Použitím View Controls/ovládací prvky pro 
pohled změňte pohled na TOP/Horní. 

2. Zvolte vrchní stěnu a otevřete příkaz 
Opening/Otvor. 
Ribbon/Pás karet: Wall/stěna > Opening 
Flyout/Rozbalovací nabídka otvor > 
Opening/Otvor 

 

3. V okně nástrojů nastavte šířku na 4000, 
výšku na 4000, Vertical 
alignment/vertikální zarovnání na 
Sill/nadpraží a Sill height/Výška nadpraží 
na 0 jednotek. 

 

Umístěte otvor tak, aby byl zarovnán 
napravo s okrajem chodby. 

 

4. Zopakujte postup pro druhý otvor na spodní 
zdi a pro třetí na pravé zdi. Jednotlivá 
umístění jsou definována chodbami.   

5. Uložte výkres jako <FDS-
ROOT>\Layout\Building.dwg. 
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11 Vkládání dveří

1. Otevřete panel Design/Návrh. 

V panelu nástrojů Doors/Dveře zvolte typ 
Hinged – Single – Exterior/Otočné – 
Jednokřídlé - venkovní. 

 

V okně vlastností nastavte Standard 
size/Standardní velikost na 1000 x 2200. 

 

Zvolte severní vnější stěnu a umístěte dveře 
na horní otvor. Přesné umístění dveří bude 
přiřazeno později. 

2. Zvolte dveře a kliknutím na šipku dolů 
změňte směr otvírání dveří a na šipku 
vpravo pro změnu strany závěsu pantů.  

 

3. Otevřete příkaz Reposition From/Změnit 
umístění z. 
Ribbon/Pás karet: Door/Dveře > 
Modify/Upravit > Reposition From/Změnit 
umístění z 

 

Jako počáteční bod zvolte (P1) a bod (P2) 
jako referenční bod. Vložte 500 jako 
hodnotu odsazení a pro potvrzení stiskněte 
klávesu [ENTER]. 

 

 

4. Zopakujte tento postup pro umístění dveří 
na spodní zdi k pravé straně a na pravé zdi 
nad otvor.  

5. Uložte výkres jako <FDS-
ROOT>\Layout\Building.dwg. 
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12 Vkládání oken 

1. Na stavovém řádku ve spodní části 
obrazovky klikněte na Cut Plane/rovina 
řezu. 

 

U možnosti Display Above/Zobrazit nad 
rozsahem změňte hodnotu na 5000 a u 
možnosti Cut Height/Výška řezu na 
hodnotu 3000. 

 

Pro potvrzení změn stisknete OK. 

2. Otevřete panel Design/Návrh. 

Z karty vlastností Window/Okna zvolte 
typ Casement/Jednokřídlé. 

 

V okně nástrojů nastavte šířku na 1000 a 
výšku na 1800, Vertical 
alignment/Vertikální zarovnání na 
Head/nadpraží a Head height/výška 
nadpraží na 4000. 

 

3. Zvolte severní vnější zeď a umístěte do ní 
okno napravo od bodu C5 sloupové 
osnovy. Přesné umístění okna bude 
upřesněno později. 

 

4. Zvolte okno. 

Vyberte příkaz Add Selected/Přidat 
vybrané.  
Ribbon/Pás karet: Window/Okno > 
General/Obecné  > Add Selected/Přidat 
vybrané 
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Použitím klávesy [ŠIPKA DOLŮ] otevřete 
menu Options/možnosti a vyberte 
možnost Cycle measure/způsob měření 
tolikrát, dokud není levý spodní okraj 
nového okna definován jako bod vložení.  

 

Napravo vedle prvního okna přidejte 
dalších šest oken a u každého definujte 
místo vložení v pravém dolním rohu 
předcházejícího vloženého okna. 

 

5. Vyberte všechna okna. 

Otevřete příkaz Center/Střed. 
Ribbon/Pás karet: Window/Okno > 
Modify/Upravit > Center/Střed 

 

Stiskněte [ENTER] k potvrzení 
referenčních bodů. 

Zvolte (P1) jako první referenční bod a 
(P2) jako druhý referenční bod. 

 

6. Vyberte všechna okna. 

Otevřete příkaz AEC Array/Pole AEC. 
Ribbon/Pás karet: Window/Okno > 
Modify/Upravit > AEC Array/Pole AEC 

 

Jako výchozí bod zvolte levý okraj řady 
oken. 

Pomocí klávesy [ŠIPKA DOLŮ] otevřete 
menu Options/možnosti a zvolte 
možnost Pick Array Distance/Vyberte 
odstup v rámci pole. 

Pro definování vzdálenosti zvolte bod 
(P1) a bod (P2). 

 

Táhněte kurzorem doprava, dokud se 
všechna tři nová okna nezobrazí a poté 
příkaz dokončete klávesou [ENTER]. 

 

7. Zvolte druhé pole oken zprava. 

Otevřete příkaz Mirror/Zrcadlit. 
Ribbon/Pás karet: Home/Výchozí > 
Modify/Upravit > Mirror/Zrcadlit 

 

8. Postupně zvolte jakékoliv dva body na 
ose x 3 pro zrcadlení pole okna na této 
ose. 

Potvrďte možnost Erase Source 
Object/Chcete vymazat výchozí objekty 
stisknutím tlačítka No/Ne. 

Zvolte zrcadlené pole oken na jižní vnější 
zdi. 

9. Otevřete příkaz AEC Array/Pole AEC. 

Jako výchozí hranu zvolte levý okraj 
zrcadleného okna. 

Pomocí [ŠIPKA DOLŮ] otevřete menu 
Options/Možnosti a zvolte možnost Pick 
Array Distance/Vyberte odstup v rámci 
pole. 

Pro definování vzdálenosti zvolte body 
(P1) a (P2). 
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Táhněte kurzorem doleva, dokud se 
nezobrazí všechna tři nová okna a poté 
zavřete příkaz stisknutím klávesy [ENTER]. 

 

10. Okna a dveře na levé straně budovy 
přidejte samostatně tak, jak ukazuje 
výkres níže. 

Tip: Primárně pracujte v pohledu horní. V 
případě potřeby pohled změňte. 

Použijte přidanou rovinu řezu k umístění 
horních oken.  

11. Zvolte vnější referenci ExteriorSite. 

Pravým tlačítkem myši otevřete 
kontextové okno a zvolte možnost 
Unload/Odpojit. 

 

12. Uložte soubor pod názvem <FDS-
ROOT>\Layout\Building.dwg. 
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13 Konstrukce ocelového mezipatra

1. Otevřete aplikaci AutoCAD Architecture. 

2. Otevřete soubor FDS-
ROOT>\Layout\Details\Mezzanine.dwg. 

V tomto souboru je již zvoleno optimální 
výchozí nastavení pro umístění mezipatra 
v závislosti na modelu budovy. 

3. Na stavovém řádku ve spodní části 
obrazovky klikněte na StandardDisplay 
configuration/Standard. 

Ověřte, že zobrazení je nastaveno na 
Construction Analysis/Konstrukční. 

 

4. Otevřete panel nástrojů Design/návrh a 
zvolte modul Beam/Trám. 

V okně vlastností změňte styl na IPB 180 
a nastavení Justify/Zarovnání na Top 
Center/nahoře ve středu. 

 

Umístěte tři trámy zleva doprava na 
existující sloupy. Jako bod úchopu 
použijte konce těžištních os. 

 

5. Vyberte prostřední sloup v řadě a 
otevřete příkaz Add Trim Plane/Přidat 
rovinu oříznutí. 

Jako rovinu ořezu zvolte spodní okraj 
prostředního trámu. 

6. Změňte nastavení obrazovky na Medium 
Detail. 

Na stavovém řádku v pravé spodní části 
obrazovky klikněte na červenou žárovku. 

Zvolte End Object Isolation/Ukončit 
izolaci objektu pro zobrazení dalších 
přímek.  

 

7. Na panelu nástrojů Design/návrh klikněte 
pravým tlačítkem myši na modul 
Beam/Trám a v Apply tool properties 
to/použít vlastnosti nástroje na zvolte 
funkci Linework/Skica. 
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Zvolte podélné přímky a pro potvrzení 
stiskněte klávesu [ENTER]. 

V dialogovém okně zvolte možnost Erase 
layout geometry/odstranit geometrii 
rozvržení a potvrďte kliknutím na OK. 

 

V okně vlastností zvolených trámů 
změňte style na IPB-180 a 
justification/zarovnání na Bottom 
center/dole ve středu 

 

Obrázek níže ukazuje aktuální stav 
návrhu. 

 

8. Použijte View Controls/ovládací prvky 
pro pohled a přepněte pohled na 
TOP/Horní a změňte styl zobrazení na 2D 
Wireframe/2D drátový model. 

 

Klikněte na Value of the 
elevation/Odsazení výšky a nastavte Z 
offset/Odsazení Z na 3380. Pro potvrzení 
klikněte na OK. Možnost spusťte 
kliknutím na ikonu s žárovkou napravo. 

 

9. Otevřete panel nástrojů Design a zvolte 
modul Slab/Deska. 
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V okně vlastností nastavte 
Thickness/Tlouštka na 30 a možnost 
Justify/zarovnání na Bottom/Dole 

 

Zvolte body (P1) až (P6). 

Pravým tlačítkem myši klikněte uvnitř 
modelového pole a zvolte možnost 
Close/Uzavřít. 

Zavřete příkaz stisknutím klávesy 
[ENTER]. 

 

10. Nastavte výšku na 3410. 

 

11. Otevřete kartu vlastností Design/Projekt 
a zvolte modul Stair/Schodiště. 

 

V okně vlastností nastavte Style/Styl na 
Steel/Ocelové, Shape/Tvar na 
Straight/Přímé, Vertical 
orientation/Vertikální orientace na 
Down/Dolů, width/šířku na 950, 
height/výšku na 3410, Justify/zarovnání 
na Right/Vpravo a Tread/Stupeň na 270. 

 

Umístěte schodiště dle obrázku níže a 
nastavte jeho natočení na 270 stupňů. 
Pro ukončení příkazu stiskněte klávesu 
[ENTER]. 
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12. Vyberte schodiště. 

Otevřete příkaz Add Railing –
 Stair Flight/Přidat zábradlí – rameno 
schodiště. 
Ribbon/Pás karet: Stair/Schodiště > 
Modify/Upravit > Add Railing 
Flyout/Rozbalovací nabídka přidat 
schodiště > Stair Flight/ Rameno 
schodiště 

 

Klikněte na levý okraj (P1) a pravý okraj  
(P2) ramena schodiště. 

Pro ukončení příkazu stiskněte klávesu 
[ESC]. 

 

Zvolte obě zábradlí, která byla přidána, a 
v okně vlastností změňte styl na 
Steel (4) – horizontal a 
Side offset/odsazení strany na 0. 

 

13. Otevřete příkaz Railing/Zábradlí. 
Ribbon/Pás karet: Home/Výchozí > 
Build/Sestavit > Stair Flyout/Rozbalovací 
nabídka Schodiště> Railing/Zábradlí 

 

Použitím klávesy [ŠIPKA DOLŮ] otevřete 
menu Options/možnosti a zvolte 
možnost Attach/připojit a možnost 
None/žádné. 

 

V okně vlastností změňte styl na 
Steel (4) - horizontal. 

Zvolte  body (P1) až (P6). 

Pro uzavření příkazu dvakrát stisknete 
klávesu [ENTER]. 
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Obrázek níže ukazuje výsledné mezipatro.  

 

14. Uložte soubor pod názvem <FDS-
ROOT>\Layout\Mazzanine.dwg. 
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14 Tok materiálu

1. Otevřete aplikaci AutoCAD Architecture. 

2. Otevřete soubor <FDS-
ROOT>\Layout\MaterialFlow.dwg. 

3. Připojte výkres <FDS-
ROOT>\Layout\Building.dwg do souřadnic 
0,0,0 se zvolenou možností overlay jako 
externí referencí. 

 

4. Otevřete příkaz Freeze/Zmrazit. 
Ribbon/Pás karet: Home/Výchozí > 
Layers/Hladiny > Freeze/Zmrazit 

 

 

Zmrazte hladiny obsahující rastr budovy, 
sloupy a střešní trámy.  

Pokud je to nezbytné, můžete zmrazit i 
ostatní hladiny. Pro následující kroky jsou 
potřebné pouze hladiny obsahující síť 
chodeb a obvodové zdivo.  

5. Otevřete Material Flow Browser/Prohlížeč 
toku materiálu. 
Ribbon/Pás karet: Factory> Tools/Nástroje > 
Palettes Flyout/Rozbalovací nabídka Palety 
> Material Flow/Tok materiálu 

 

6. Otevřete panel nástrojů Stations/Stanice. 

Pravým tlačítkem myši klikněte uvnitř okna 
a otevřete funkci Create/Vytvořit. 

 

Zvolte křivku dle obrázku pojmenovanou 
Milling a stiskněte [ENTER] pro potvrzení. 

 

Klikněte do oblasti křivky pro definování 
místa připojení stanice. 

V Material Flow Browser/prohlížeči toku 
material pojmenujte stanici Milling. 
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7. Pravým tlačítkem myši klikněte na novou 
stanici a zvolte funkci Properties/Vlastnosti.  

 

Otevře se okno Factory Object 
Properties/Vlastnosti objektu výrobní linky. 
V tomto okně potvrďte následující hodnoty: 

 

8. Zopakujte postup pro stanici Cutting, v 
němž nastavte následující hodnoty: 

 

9. Aktivujte panel nástrojů Products/Produkty 
a pravým tlačítkem klikněte na Assembly A. 

Zvolte funkci Add/Přidat. 

 

Pojmenujte nově přidaný výkres jako 
Product 2. 

10. Aktivujte panel nástrojů 
Routings/Směrování. Pravým tlačítkem 
myši klikněte uvnitř okna a  vyberte funkci 
Create/Vytvořit.  

Panel nástrojů Products/Produkty je 
aktivován automaticky. 

Zvolte Product 2 pro definování  směrování.  

Vytvořte trasu zvolením Receiving, Cutting, 
Milling and Welding stanic. 

Uzavřete příkaz stisknutím klávesy [ENTER]. 

 

11. Pravým tlačítkem klikněte na Operation: 
1/Operace: 1 Receiving  a spusťte funkci 
Redefine path/Předefinovat cestu. 

 

Jako spojovací režim zvolte možnost 
Path/Cesta v menu Options/Možnosti. 
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Zarovnejte cestu se směrem chodby 
postupným kliknutím na vrcholy. 

Stiskněte [ENTER] pro uzavření příkazu. 

 

12. Zvolte operaci Receiving v Material Flow 
Browser/Prohlížeči toku materiálu. 

V okně Factory Object 
Properties/Vlastnosti objektu výrobní linky 
nastavte Operation type/Typ operace na 
Storage a Transportation type/Typ 
přepravy na Forklift. 

 

Přiřaďte následující parametry pro operace: 
Operation Operation 

type 
Transportation 
type 

Cutting Cutting Forklift 

Milling Milling Forklift 

Welding No Operation - 

13. Vytvořte další směrování pro Assembly A. 
Použijte stanice Welding, Mill and Drill, 
Washing  a Shipping.  

Použijte následující parametry: 

Operation Operation 
type 

Transport 
type 

Welding Welding Conveyor 

Mill and Drill Mill and Drill Conveyor 

Washing Washing Conveyor 

Shipping Storage - 

14. Vyberte směrování pro Product 1 v Material 
Flow Browser/Prohlížeč toku materiálu. 

V okně Factory Object 
Properties/Vlastnosti objektu výrobní linky 
nastavte Desired Product Rate/Požadovaná 
rychlost výroby na 60, a Part 
Quantity/Množství součástek na 1200 a 
Batch Size/velikost dávky na 30.  

 

15. Zvolte směrování pro Product 2 a nastavte 
stejné hodnoty. 

16. Zvolte směrování pro Assembly A a nastavte 
stejné hodnoty pro Desired Product 
Rate/Požadovaná rychlost výroby a Part 
Quantity/Množství součástek  jako výše.  

Potvrďte 1 jednotku jako velikost dávky. 

Tím dokončíte všechny požadované vstupy 
pro konfiguraci toku materiálu.  

17. Otevřete příkaz Machine/Stroj pro 
vyhodnocení produkce projektu. 
Ribbon/Pás karet: Factory > Material 
Flows/Tok materiálu >Flyout/Rozbalovací 
nabídka Přeprava> Machine/Stroj 
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Ukazatele hodnocení jsou nyní zobrazeny. 

18. Klikněte pravým tlačítkem na ukazatele a 
zapněte případné chybějící ukazatele.  

 

Nastavte ručičky ukazatele pro 
Utilization/Využití na 10 a 90 procent. 

 

Dva ze strojů jsou nyní označeny červeně. 
Tyto dva stroje jsou využívány nad limitem 
jejich maximální výrobní rychlosti 90 
procent. Stroj označený číslem 1 indikuje 
nejvyšší přetížení.  

 

19. Pravým tlačítkem klikněte na číslo stroje a v 
kontextovém menu zvolte možnost 
Optimization/Optimalizace > Add meter to 
dashboard/Přidat měřidlo na řídicí panel. 

Řídicí panel ukazuje výrobní rychlost ve výši 
103 procent. 

 

20. Podržte stisknutou klávesu [CTRL], zvolte 
všechna tři směrování a změňte Desired 
Product Rate/požadovaná výrobní rychlost 
na 50.  

 

Výrobní rychlost všech strojů je nyní v 
přípustném rozsahu.  

21. Pro uzavření řídicího panelu stiskněte 
tlačítko X v horním pravém rohu. 

22. Otevřete příkaz Transportation/Přeprava 
pro vyhodnocení vzdáleností přepravních 
tras a nákladů.  
Ribbon/Pás karet: Factory > Material 
Flow/Tok materiálu >Flyout/Rozbalovací 
nabídka> Transportation/Přeprava 

 

Ukazatele hodnocení jsou nyní zobrazeny. 

Klikněte na tlačítko Modify 
Settings/Upravit nastavení a zvolte 
možnost zobrazení Transport cost/Náklady 
na přepravu. 

 

Stanice označná číslem 1 ukazuje místo, ve 
kterém začínají nejvyšší náklady.  

 

23. Zvolte stanici Shipping (výběrovým oknem). 
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Otevřete příkaz Move/Posun a pomalu 
přesuňte výběr doprava bez ukončení 
příkazu. 

Ukazatelé řídicího panelu dynamicky ukazují 
negativní změnu v dopravních nákladech a 
vzdálenosti. 

 

Pro zrušení příkazu stiskněte [ESC]. 

24. Pro uzavření řídicího panelu stiskněte 
tlačítko X v pravém horním rohu. 

25. Otevřete příkaz Generate 
Report/Generovat zprávu. 
Ribbon/Pás karet: Factory > Material 
Flow/Tok materiálu > Generate 
Report/Generovat zprávu 

 

Uložte zprávu jako soubor aplikace Excel v 
jakémkoliv vámi zvoleném adresáři. 

Program Excel se otevře automaticky a 
zobrazí zprávu toku material. 

Aktivujte list Details/Podrobnosti pro 
zobrazení dat v tabulce.  

26. Uložte soubor a poté jej zavřete. 
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15 Ustavení a úprava podsestav

1. Otevřete AutoCAD Architecture. 

2. Otevřete soubor <FDS-
ROOT>\Layout\Building.dwg. 

3. Vyberte Column Grid/Sloupovou osnovu. 

Spusťte příkaz Isolate Objects/Izolovat 
objekty. 

4. Otevřete Layer Properties 
Manager/Správce vlastností hladiny. 

Postupně vytvořte čtyři nové vrstvy: 

Name Color 

Robots 5 
(blue/modrá) 

MaterialHandling 140 

SafetyGuard 1 
(red/červená) 

Process 
Equipment 

171 

5. Spusťte příkaz Circle, Center, 
Radius/Kružnice, Střed, Poloměr. 
Ribbon/Pás karet: Home/Výchozí > 
Draw/Kreslit > Circle Flyout/Rozbalovací 
nabídka kružnice> Circle, Center, Radius/ 
Kružnice, Střed, Poloměr.  

 

Střed kružnice umístěte 1000 jednotek ve 
směru osy x a 4000 jednotek ve směru osy y 
od souřadnic sloupové osnovy 2/3.  

Poloměr zvolte 3200. 

 

6. Zvolte hladinu Material Handling jako 
aktuální vrstvu. 

Otevřete Asset Browser/Prohlížeč 
komponent. 
Ribbon/Pás karet: Factory > Tools/Nástroje 
> Palettes Flyout/Rozbalovací nabídka 
palety> Asset Browser/Prohlížeč 
component.  

 

Přepněte pohled naTree View/Zobrazení 
stromu. 

 

Dvojklikem vyberte Turn Table. 
Factory Assets > Training > Material 
Handling > Turn Table 
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Umístěte Turn Table do středového bodu 
kružnice a potvrďte natočení 0 stupňů. 

7. Zvolte vrstvu Robots jako aktuální vrstvu. 

V Asset Browser/Prohlížeč komponent 
dvojklikem zvolte IRB6640_180_255. 
Factory Assets > Training > Robots > 
IRB6640_180_255 

 

Umístěte robotickou jednotku do horního 
kvadrantu kružnice a potvrďte natočení o  
-90 stupňů. 

8. Zvolte příkaz Polar Array/Polární pole. 
Ribbon/Pás karet: Home/Výchozí > 
Modify/Upravit > Arrays Flyout/Rozbalovací 
nabídka pole> Polar Array/Polární pole 

 

Zvolte robotickou jednotku a stiskněte 
[ENTER] pro potvrzení. 

Zvolte středový bod kružnice jako středový 
bod pole. 

Použitím [ŠIPKA DOLŮ] otevřete menu 
Options/Možnosti a zvolte možnost 
Assets/Položky. 

 

Vložte hodnotu 3 pro počet položek a 
stiskněte [ENTER] pro potvrzení. 

Znovu stisknete [ENTER] pro ukončení 
příkazu. 

9. Spusťte příkaz Explode/Rozložit. 
Ribbon/Pás karet: Home/Výchozí > 
Modify/Upravit > Explode/Rozložit 

 

Vyberte pole a stiskněte [ENTER]. 
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10. V Asset Browser/Prohlížeč komponent 
dvojklikem zvolte Robot Controller. 

 

Umístěte tři tyto komponenty tak, jak je 
ukázáno na obrázku dole: 

 

11. Nastavte vrstvu Process Equipment jako 
aktuální. 

V Asset Browser/Prohlížeč komponent 
dvojklikem zvolte Miller wire welder. 
Factory Assets > Training > Process 
Equipment > Welding Machine 

 

Umístěte komponentu tak, jak ukázáno na 
obrázku dole: 

 

12. Vyberte na začátku vytvořenou kružnici a 
smažte ji stisknutím [Del]. 

13. Nastavte vrstvu SafetyGuard jako aktuální.  
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Otevřete příkaz Polyline/Křivka a veďte dvě 
křivky tak, jak je ukázáno na obrázku dole:  

 

V Asset Browser/Prohlížeč komponent 
zadejte do vyhledávače pojem Safety 
Fence/zábradlí  a klikněte na tlačítko Search 
Asset/hledat komponenty.  

 

V nalezených výsledcích dvojklikem zvolte 
Safety Fence (Chain)/Zábradlí (řetězec). 

 

Pomocí [ŠIPKA DOLŮ] otevřete menu 
Options/Možnosti a zvolte možnost 
Polyline/Křivka. 

Zvolte obě křivky a stisněte pro potvrzení 
[ENTER]. 

14. Zvolte vytvořenou geometrii. 

Potvrďte WBLOCK/PIŠBLOK v Command 
Line/Příkazový řádek a stiskněte [ENTER]. 

Zvolte možnost Objects/objekty > Delete 
from drawing/Vymazat z výkresu a 

potvrďte C:\FDS-
ROOT\Layout\Production.dwg jako název 
souboru a cestu.  

Klikněte na OK pro potvrzení.  

 

15. Zavřete aktuální výkres bez uložení. 

16. Otevřete soubor <FDS-
ROOT>/Layout/Production.dwg. 

 

Otevřete funkci Sync 
Inventor/Synchronizovat aplikaci Inventor. 
Ribbon/Pás karet: Factory > Suite 
Workflows/Pracovní postupy sady > Sync 
Inventor/Synchronizovat aplikaci Inventor 

 

Potvrďte výzvu k uložení souboru. 
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Souběžná sestava v Inventoru je nyní 
vytvořena pod názvem souboru <FDS-
ROOT>/Layout/Production.iam a otevřena 
v Inventoru. 

 

Ochranné zábradlí bylo vytvořeno 
automaticky pomocí funkce Asset-Chaining. 

17. V Model Browser/Model pravým tlačítkem 
myši otevřete odkaz dwg Production a 
zvolte možnost menu Layer 
Settings…/nastavení hladin  

 

Deaktivujte všechny hladiny a změny 
potvrďte kliknutím na OK. 

 

18. Ujistěte se, že možnost Snap to 
Floor/Přichytit k podlaze je aktivní. 
Ribbon/Pás karet: Factory > 
Options/Možnosti > Snap Types/Typy 
uchopení > Snap to Floor/Přichytit k podlaze 

 

Použitím ViewCube/pohledové kostky 
(pravý horní roh modelového okna), změňte 
pohled na TOP/Shora. 

 

V User Interface/Uživatelské rozhraní 
otevřete prohlížeč Factory 
Assets/Komponenty výrobní linky. 
Ribbon/Pás karet: View/Pohled > 
Window/Okna > User Interface/Uživatelské 
rozhraní > Factory AssetsKomponenty 
výrobní linky 
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V prohlížeči Factory Assets/Komponenty 
výrobní linky dvojklikem zvolte 
komponentu Pallet Conveyor Turn Table. 
Factory Assets/komponenty výrobní linky > 
Training > Conveyor > Pallet  > Pallet  
Conveyor Turn Table 

 

Kliknutím na bod vložení umístěte 
komponentu tak, jak je ukázáno na obrázku 
dole, a potvrďte natočení 0 stupňů.  

 

Pravým tlačítkem myši otevřete kontextové 
menu a pro ukončení příkazu klikněte na 
Done/hotovo. 

 

19. Ujistěte se, že možnost úchopu Snap to 
Connector/Přichytit ke konektoru je aktivní. 

 

V prohlížeči Factory Assets dvojklikem 
zvolte komponentu Straight Pallet 
Conveyor. 

 

Umístěte komponentu na spojovací prvky 
(zelené kuličky) pod točnou (Pallet Conveyor 
Turn Table). 

20. Umístěte další točnice a přímý paletový 
dopravník nad spojovací prvky tak, jak 
ukazuje obrázek dole. 

Ujistěte se, že motory jsou správně 
zarovnány. 
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21. Uložte sestavu a otevřete funkci Sync 
AutoCAD/Synchronizovat aplikaci 
AutoCAD. 
Ribbon/Pás karet: Factory > Suite 
Workflows/Pracovní postupy sady > Sync 
AutoCAD/Synchronizovat aplikaci AutoCAD.  

 

 Tímto se aktualizuje AutoCAD výkres 
Production.dwg, tj. přidají se nově 
vytvořené komponenty.  

Na otázku, zda si přejete nově vytvořený 
Production.dwg otevřít v AutoCADu, zvolte 
odpověď  Yes/Ano. 

 

22. Vyberte všechny prvky plotu.  

Přiřaďte hladinu SafetyGuard výběru 
použitím Layer Selection/Hladina. 
Ribbon/Pás karet: Home/Výchozí > 
Layer/Hladiny > Layer Selection/Hladina 

 

23. Otevřete Layer Properties 
Manager/Správce vlastností hladiny. 

Vytvořte novou vrtsvu, pojmenujte ji 
Conveyor a dejte ji barvu 83. 

Vyberte všechny dopravníky a přesuňte je 
do této hladiny.  

Uložte výkres a a zavřete jej.
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16 Tvorba souhrnných výkresů

1. Otevřete AutoCAD Architecture. 

2. Vytvořte nový výkresový soubor pomocí 
QNEW. 

3. Uložte soubor jako 
<FDS-ROOT>/Layout/Overall.dwg. 

4. Otevřete Reference Manager/Externí 
reference. 

Klikněte na tlačítko Attach DWG/připojit 
DWG. 

Vyberte soubor <FDS-ROOT>/Layout/ 
ExteriorSite.dwg. 

Vložte výkres do souřadic 0,0,0 se zvolenou 
možností overlay/podložit. 

5. Zopakujte postup pro následující soubory: 

 Building.dwg 

 Production.dwg 

 Building_OfficeGroundFloor.dwg 

6. Vložte výkres   
Building_OfficeFirstFloor.dwg do souřadnic  
0,0,3000 se zvolenou možností overlay. 

7. Uložte výkres a otevřte funkciSync 
Inventor/Synchronizovat aplikaci Inventor. 

8. Zavřete soubor Inventoru. 
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17 Vytvoření system válečkových dopravníků

1. Otevřete AutoCAD Architecture. 

2. Otevřete soubor 
<FDS-ROOT>\Layout\Production.dwg. 

3. Otevřete External References 
Manager/Externí reference. 

Klikněte na Attach DWG/Připojit DWG. 

Zvolte soubor 
<FDS-ROOT>\Layout\Details\OtherProduct
ion.dwg. 

Vložte výkres do souřadnic 0,0,0 se 
zvolenou možností overlay/podložit.  

4. Klikněte na soubor v okně External 
References/Externí reference a zvolte 
funkci Bind…/Vázat…. 

 

V otevřeném dialogovém okně zvolte 
možnost Insert/Vložení, pro potvrzení 
stiskněte OK. 

Tím změníte reference na blok.  

 

5. Vyberte ohraničující referenční blok a 
spusťte příkaz Explode/Rozložit.  

Ribbon/Pás karet: Home/Výchozí > 
Modify/Upravit > Explode/Rozložit 

 

Rozložený blok je stale obsažen ve 
výkresovém seznamu bloků. Odstraníte jej 
následujícím postupem.  

6. Otevřete příkaz Purge. 
Application menu/Menu aplikace > Drawing 
Utilities/Pomůcky pro kreslení > Purge/Čistit 

 

V okně vyberte jméno bloku a zaškrkněte 
možnost Purge nested items/Čistit vnořené 
položky. 

Pro ukončení funkce klikněte na Purge/čistit 
a zavřete dialogové okno. 
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7. Otevřete funkci Sync inventor. 

Potvrďte výzvu k uložení a zavřete soubor.  

Rozložení v Inventoru je vytvořeno na 
základě výkresu aplikace AutoCAD a 
otevřeno v program Inventor. 

8. Použijte pohledovou kostku a změňte 
pohled na TOP/Shora. 

9. V User Interface otevřete prohlížeč Factory 
Assets/Komponenty výrobní linky. 
Ribbon/Pás karet: View/Pohled > 
Window/Okna > User Interface/Uživatelské 
rozhraní > Factory Assets/Komponenty 
výrobní linky.  

Zapněte možnost úchopu Snap to 
Floor/Přichytit k podlaze, Snap to 
Connector/Přichytit ke konektoru a Snap to 
DWG overlay/Přichytit k překrytí DWG. 

 

10. V prohlížeči Factory Assets/Komponenty 
výrobní linky dvojklikem zvolte Straight 
Roller Conveyor. 
Factory Assets > System Assets > Conveyor 
> Roller > Straight Roller Conveyor 
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Komponentu umístěte nad 2D geometrii 
kliknutím na bod vložení a zadejte natočení 
0 stupňů. Pravým tlačítkem myši otevřete 
menu Options/možnosti a ukončete příkaz 
kliknutím na Done/hotovo. 

 

11. Vyberte komponentu. 

Otevřete funkci Reposition/Přemýstit. 
Ribbon/Pás karet: Factory > Layout 
Tools/Nástroje rozvržení > 
Reposition/Přemístit 

 

Jako základní bod nastavte levý spodní roh 
dopravníku tím, že na něj klikněte. 

  

Dejte kurzor na fialovou kouli a klikněte na 
její obvod. 

 

Komponenta nyní sleduje kurzor. Klikněte 
na spodní levý roh 2D geometrie pro 
definování bodu určení. 

 

Pravým tlačítkem myši otevřete menu 
Options/možnosti a příkaz ukončete 
kliknutím na Done/hotovo.  

Z prohlížeče Factory Assets/Komponenty 
výrobní linky vložte druhý identický 
dopravník. 

Tento dopravník přemístěte vedle prvního 
dopravníku tak, že zelené umísťovací body 
jsou přitahovány jeden k druhému. 

 

Jakmile je nový dopravník přichycen, 
klikněte levým tlačítkem myši pro umístění.  

Příkaz ponechte aktivní. Na konec druhého 
dopravníku vložte třetí.  

Stiskněte [ESC] pro ukončení procesu. 
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12. Otevřete prohlížeč Factory 
Properties/Vlastnosti výrobní linky. 
Ribbon/Pás karet: View/pohled > 
Window/okna > User Interface/uživatelské 
rozhraní > Factory Properties/vlastnosti 
výrobní linky 

 

Vyberte dopravník, který byl umístěn jako 
poslední. 

V okně Factory Properties/Vlastnosti 
výrobní linky, klikněte na malou šipku 
doprava vedle parameteru length/délka pro 
otevření funkce Measure/odměřit.  

 

Zvolte osu 2D geometrie dopravníku. Délka 
osy je přenesena do parametru. Stiskněte 
[ENTER] pro potvrzení změny. 

 

 

13. Otevřete funkci  Sync AutoCAD. 

Potvrďte, že sestava byla uložena, a 
otevřete výkres v AutoCADu. 

Vyberte blok, který byl využit jako šablona 
dopravníku a smažte jej.  

 

14. Uložte soubor  jako 
<FDS-ROOT>\Layout\Production.dwg.



 

  48 

18 Vkládání a umísťování komponent 

1. Otevřete Inventor. 

2. Otevřete soubor 
<FDS-ROOT>\Layout\Production.iam. 

3. Použitím pohledové kostky (pravý horní roh 
modelového okna) zvolte 
isometric/Isometrický pohled a přibližte si 
vysokozdvižný vozík. 

4. Ujistěte se, že možnost úchopu Snap to 
Surface/Přichytit k povrchu je aktivní, 
zatímco možnost Snap to Floor/Přichytit k 
podlaze je neaktivní. 
Ribbon/Pás karet: Factory > 
Options/Možnosti > Snap Types/Typy 
uchopení 

 

5. Otevřete prohlížeč Factory 
Assets/Komponenty výrobní linky. 
Ribbon/Pás karet: View/Pohled > 
Window/Okna > User Interface/Uživatelské 
rozhraní > Factory Assets/Komponenty 
výrobní linky.  

6. V prohlížeči Factory Assets/Komponenty 
výrobní linky. 

dvojklikem zvolte komponentu Pallet. 

Factory Assets > System Assets > Material 
Handling > Pallet 

 

Umístěte paletu na rameno 
vysokozdvižného vozíku. Potvrďte natočení 
0 stupňů a stiskněte [ENTER] k ukončení 
příkazu. 

 

7. Použijte pohledovou kostku k nastavení 
pohledu naTOP/ Shora. 

8. Otevřete funkci Align/Zarovnat. 
Ribbon/Pás karet: Factory > Layout Tools 
/Nástroje rozvržení> Align/Zarovnat 

 

Zvolte paletu. Zvolená paleta je zvýrazněna 
modře. 
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V dialogovém okně Align/Zarovnat klikněte 
na tlačítko Reference/Referenční(1) a zvolte 
vysokozdvižný vozík. Vysokozdvižný vozík je 
nyní zvýrazněn bíle. 

Klikněte na tlačítko Align Orientation 
X/Zarovnat orientaci X (2). Pro potvrzení 
stiskněte OK. 

 

9. Otevřete prohlížeč Factory 
Properties/Vlastnosti výrobní linky z User 
Interface/Uživatelské rozhraní. 
 
Ribbon/Pás karet: View/Pohled > 
Window/Okna > User Interface/Uživatelské 
rozhraní > Factory Properties/Vlastnosti 
výrobní linky.  

Zvolte paletu. 

Změňte šířku na 1200, výšku na 140 a délku 
na 800. 

Pro potvrzení změn stiskněte [ENTER]. 

 

10. Otevřete příkaz Reposition/Přemístit. 

Umístěte počátek pohybu do kteréhokoliv 
bodu na paletě. 

Klikněte na rovinu XY polohovací pomůcky a 
přemístěte ji tak, že je více či méně ve 
středu ramena vysokozdvižného vozíku.   

 

Pravým tlačítkem myši otevřete menu 
Options/možnosti a ukončete příkaz 
kliknutím na Done/hotovo. 

11. Zůstaňte v pohledu TOP/Shora a bedny si 
přibližte. 

 

12. Otevřete funkci Align/Zarovnat. 

Pomocí tlačítka Components/komponenty 
zvolte bedny 2, 3 a 4 . 

Pomocí tlačítka Reference/referenční 
vyberte bednu  1. 
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Klikněte na Align Position: Horizontal 
Center/Zarovnat polohu horizontálně na 
střed a Align Orientation X/Orientace 
zarovnání X. Pro potvrzení klikněte na 
Apply/Použít. 

 

V dialogovém okně se přepněte na kartu 
Distribute/Rozmístit. 

Klikněte na tlačítko 
Components/komponenty a vyberte 
všechny čtyři bedny. 

Klikněte na Align Distribution: Vertical 
Center/Zarovnat rozmístění vertikálně na 
střed a pro potvrzení výberu stiskněte OK. 

 

13. Uložte sestavu a otevřete funkci Sync 
AutoCAD/Synchronizovat aplikaci 
AutoCAD. 

14. Otevřete nákres v AutoCADu. 

15. V pohledu zhora si bedny přibližte a vyberte 
je. 

Zkopírujte bedny a umístěte je o 2000 
doprava.  

 

16. Uložte výkres a otevřete funkci Sync 
Inventor/Synchronizovat aplikaci Inventor. 

17. V Inventoru si rozvržení beden přibližte. 

18. Ujistěte se, že funkce Snap to Vertex or 
Edge/Přichytit k vrcholu nebo hraně je 
aktivní. 
Ribbon/Pás karet: Factory > 
Options/možnosti > Snap Types/Typy 
uchopení > Snap to Vertex or Edge/Přichytit 
k vrcholu nebo hraně 

 

19. Zvolte spodní okraj pravé krabice. 
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Otevřete funkci Reposition/Přemístit. 

Zvolte střed spodního pravého okraje bedny 
jako počátek. 

 

Klikněte na fialovou kouli. 

Umístěte horní bednu do středu horního 
okraje spodní bedny tak, jak je ukázáno na 
obrázku. 

 

Pravým tlačítkem myši otevřete menu 
Options/možnosti a ukončete příkaz 
stisknutím na Done/Hotovo. 

20. Použitím příkazu Align/Zarovnat zarovnejte 
horní bednu se spodní bednou, a to pomocí 
možností Horizontal Center/Horizontálně 
na střed a Vertical Center/Vertikálně na 
střed. 

21. Obdobně na sebe naskládejte ostatní 
bedny. 

22. Obdobně vložte další paletu a zarovnejte její 
velikost a polohu tak, aby ležela na první 
paletě.  

 

23. Uložte sestavu a otevřete funkci Sync 
AutoCAD/Synchronizovat aplikaci 
AutoCAD. Neotvírejte soubor DWG. 
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19 Vložení rozsáhlých sestav

1. Otevřete Inventor. 

2. Vytvořte novou součást. 
Quick Access Toolbar/Panel nástrojů rychlý 
přístup > New Flyout/Rozbalovací nabídka 
Nový> Part/Součást 

 

3. Otevřete funkci Derive. 
Ribbon/Pás karet > 3D Model > 
Create/Vytvoření > Derive/Odvozená 
komponenta 

 

V dialogovém okně Open/Otevřít otevřete 
kořenový adresář pomocí tlačítka 
Workspace/Pracovní prostředí. 

V následující cestě  
<FDS-ROOT>\New Objects\Hardinge\  
klikněte na soubor  __Hardinge.iam a 
otevřete jej kliknutím na Open/Otevřít. 

 

4. Na první kartě otevřeného dialogového 
okna zvolte styl Single Solid Body 
Merging/Jediné objemové těleso.   

 

Na kartě Options/Možnosti zvolte 
následující možnosti a klikněte na OK. 
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5. Je-li to nutné, otevřete panel nástrojů 
Browser. 
Ribbon/Pás karet > View/Pohled > 
Window/Okna > User Interface 
Flyout/Rozbalovací nabídka uživatelské 
rozhraní > Browser/Prohlížeč 

 

V Browser/Prohlížeči klikněte pravým 
tlačítkem na Solid1/Těleso1 a zvolte 
možnost Edit Form/Upravit tvar. 

 

Model bude nyní načten do aplikace 
Inventor Fusion pro editaci. 

6. V Inventoru Fusion vyberte vnitřní stranu 
levého okraje dveří.  

 

Zvolte funkci Press/Pull/Tlačit táhnout. 

 

V otevřeném menu zvolte možnost To/Na. 

 

Natočte pohled tak, aby byla vidět protější 
strana a vyberte ji.  
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Pro uzavření vysunutí klikněte na OK. 

 

7. Nyní obdobně uzavřete mezeru na pravé 
straně stroje.  

8. Klikněte na Return to Inventor/Zpět k 
Inventoru pro ukončení práce v Inventoru 
Fusion. 

 

9. V prohlížeči klikněte pravým tlačítkem 
na_Hardinge.iam a zvolte možnost 
Delete/Odstranit. 

 

10. Uložte návrh pod názvem 
<FDS-ROOT>\Temp\Hardinge.ipt a zavřete 
jej. 

11. Otevřete funkci Import Asset/Import 
komponent. 
Ribbon/Pás karet > Get Started/Začínáme 
>Factory Launch/Spuštění výrobní linky > 

Create Asset/Vytvořit komponentu > Import 
Asset/Import komponent 

 

Zvolte soubor  
<FDS-ROOT>\Temp\Hardinge.ipt a klikněte 
na Open/Otevřít. 

Návrh je načten do Asset Builder/Generátor 
komponent. 

12. Oteřete funkci Landing Surface/Povrch 
základny. 
Ribbon/Pás karet > Asset Builder/Generátor 
komponent > Author/Vytváření > Landing 
Surface/Povrch základny 

 

Vyberte spodní plochu krytování stroje a 
definujte ji jako povrch základny.  

 

V dialogovém okně Landing Surface 
/Povrch základny klikněte na Select 



 

  55 

Insertion Point/Bod vložení a vyberte dva 
níže zvýrazněné body. Změny potvrďte 
kliknutím na OK.  

 

13. Oteřete funkci Asset Properties/Vlastnosti 
komponenty. 
Ribbon/Pás karet > Asset Builder/Generátor 
komponent > Author/Vytvořit > Asset 
Properties/Vlastnosti komponent 

 

Na kartě General/Obecné potvrďte název 
CNC a společnost Autodesk a klikněte na 
OK. 

 

14. Uložte soubor. 

15. Otevřete funkci Publish Asset/Publikovat 
komponentu. 
Ribbon/Pás karet > Asset Builder/Generátor 
komponent > Publish/Publikovat > Publish 
Asset/Publikovat komponentu.  

 

Potvrďte název komponenty CNC a zvolte 
Process Equipment jako cílový adresář. Pro 
potvrzení stiskněte OK. 

 

16. Uzavřete součást. 

17. Otevřete sestavu 
<FDS-ROOT>\Layout\Production.iam. 

18. Použitím pohledové kostky změňte pohled 
na TOP/Shora. 

19. Kliknutím na User Interface/Uživatelské 
rozhraní otevřete prohlížeč Factory 
Assets/Komponenty výrobní linky  
Ribbon/Pás karet > View/Pohled > 
Window/Okna > User Interface/Uživatelské 
rozhraní > Factory Assets/Komponenty 
výrobní linky 
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V prohlíči Factory Assets/Komponenty 
výrobní linky dvojklikem zvolte možnost 
CNC. 
Factory Assets > Training > Equipment > 
CNC 

 

Umístěte komponentu tak, jak je ukázáno 
na obrázku dole, a potvďte natočení 180 
stupňů.  

 

Pro dokončení příkazu stiskněte klávesu 
[ESC]. 

20. Uložte sestavu a otevřete funkci Sync 
AutoCAD/Synchronizovat aplikaci 
AutoCAD. Neotvírejte soubor DWG.
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20 Práce s variantami a konektory

1. Otevřete Inventor. 

2. Otevřete soubor 
<FDS-ROOT>\New Objects\Container.ipt. 

3. Uložte součást pod názvem 
<FDS-ROOT>\Temp\Container.ipt. 
Ribbon/Pás karet > Menu Browser/Menu 
aplikace > Save As/Uložit jako > Save 
As/Uložit jako 

 

4. Zavřete soubor. 

5. Otevřete  funkci Import Asset/Import 
komponent. 

Zvolte soubor 
<FDS-ROOT>\Temp\Container.ipt a klikněte 
na Open/Otevřít. 

Součást je načtena do Asset 
Builder/Generátor komponent. 

6. Otevřete funkci Landing Surface/Povrch 
základny. 

Zvolte spodní plochu nohy kontejneru a 
vyberte ji.  

 

V dialogovém okně Landing Surface/Povrch 
základny klikněte na Select insertion 

points/Bod vložení a z prohlížeče zvolte 
zvýrazněný Work Point1/Pracovní bod1. 

 

Pro uzavření dialogového okna klikněte na 
OK. 

7. Použitím [F6] vyberte výchozí pohled.  

8. Otevřete funkci Define 
Connector/Definovat konektor. 
Ribbon/Pás karet > Asset Builder/Generátor 
komponent > Author/Vytváření > Define 
Connector/Definovat konektor 
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Jako bod vložení zvolte střed levé hrany.  

 

Zvolte červenou šipku a pro definování 
zarovnání klikněte na levou vertikální hranu 
boxu. 

 

Pravým tlačítkem myši klikněte na šipku 
ukazující dolů a zvolte možnost Flip 
Axis/Obrátit směr osy. Červená šipka nyní 
ukazuje nahoru, modrá doleva a zelená 
doprava. 

 

Stiskněte klávesu [ENTER] pro ukončení 
příkazu. 

9. Stejným způsobem vytvořte druhý 
konektor.  

Obrázek dole ukazuje jeho umístění a 
zarovnání.   

 

10. Otevřete funkci Connector Class 
Properties/Definovat vlastnosti třídy 
konektoru pro komponentu. 
Ribbon/Pás karet > Asset Builder/Generátor 
component > Author/Vytvořit > Connector 
Class Properties/Definovat vlastnosti třídy 
konektoru pro komponentu.  

 

Otevřete soubor Connector Class/třídy 
konektoru s názvem  Container. 
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Zvolte normal jako hodnotu 
Properties/Vlastnosti, klikněte na 
Add/Přidat a svůj výběr potvrďte kliknutím 
na OK. 

 

11. Otevřete funkci Asset Variants/Definovat 
variant komponenty. 
Ribbon/Pás karet > Asset Builder/Generátor 
komponent> Author/Vytvořit > Asset 
Variants/Definovat variant komponenty.  

 

Podržte stisknutou klávesu [Ctrl] a současně 
zvolte parametry Length a Width a klikněte 
na tlačítko  >>. 

 

Použitím tlačítka + vytvořte tři varianty s 
následujícími hodnotami. Pro uzavření 
dialogového okna klikněte na OK. 

 

12. Uložte součást a otevřete funkci Publish 
Asset/Publikovat komponentu. 

Potvrďte název Container stackable a 
Material Handling jako cílový adresář. Pro 
potvrzení klikněte na  OK. 

 

Zavřete součást. 

13. Otevřete sestavu 
<FDS-ROOT>\Layout\Production.iam. 

14. Ujistěte se, že možnost Snap to 
Floor/Přichytit k podlaze je aktivní. 
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15. V prohlížeči Factory Assets/Komponenty 
výrobní linky dvojklikem zvolte 
komponentu Container stackable.  
Factory Assets > Training > Material 
Handling > Container stackable 

Komponentu umístěte kdekoli v přepravním 
skladišti. 

 

16. Deaktivujte možnost Snap to Floor/Přichytit 
k podlaze a ujistěte se, že možnost Snap to 
Connector/Přichytit ke konektoru je aktivní. 

17. Umístěte druhý kontejner na dříve vložený 
kontejner. Použijte body úchopu jako 
pomůcku pro umístění. 

 

18. Klikněte na tlačítko User 
Interface/Uživatelské rozhraní pro otevření 
okna Factory Properties/Vlastnosti výrobní 
linky. 

Zvolte spodní kontejner a změňte parametr 
Height na 600 mm. 

Pro potvrzení klikněte na [ENTER]. 

19. Uložte výkres a otevřete funkci Sync 
AutoCAD/Synchronizovat aplikaci 
AutoCAD. 

20. Otevřete rozvržení v AutoCAD Architecture. 

21. Otevřete Asset Browser/Prohlížeč 
komponent. 
Ribbon/Pás karet > Factory > Tools/Nástroje 
> Pallet Flyout/Rozbalovací nabídka> Asset 
Browser/Prohlížeč komponent 

V Factory Assets/Prohlížeč komponent 
dvojklikem zvolte Container stackable. 
Asset Browser/Prohlížeč komponent > 
Training > Material Handling > Container 
stackable 

22. Komponentu umístěte kdekoliv v 
přepravním skladišti. 

Zvolte vložený kontejner a klikněte na něj 
pravým tlačítkem myši.  

V kontextovém menu změňte Asset 
Variant/Varianta komponenty na 
Box_800x1200. 

 

23. Uložte výkres a otevřete funkci Sync 
Inventor/Synchronizovat aplikaci Inventor. 
Otevřete sestavu a uložte soubor.  
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21 Vložení ocelového mezipatra

1. Otevřete aplikaci AutoCAD Architecture. 

2. Otevřete soubor 
<FDS-ROOT>\Layout\Mezzanine.dwg. 

3. Otevřete funkci Convert to 3D 
Solids/Převést na 3D tělesa. 
Ribbon/Pás karet > Home/Výchozí> 
Modify/Upravit > Convert to 3D 
Solids/Převést na 3D tělesa 

 

Zvolte všechny komponenty v modelovém 
poli a pro potvrzení výběru stiskněte 
[ENTER]. 

Na výzvu, zda si přejete smazat zvolené 
komponenty, odpovězte Yes/Ano. 

Uložte výkres jako 
<FDS-ROOT>\Temp\Mezzanine_Solid.dwg 
a zavřete jej. 

4. Otevřete aplikaci Inventor. 

5. Otevřete funkci ImportDWG 
Solids/Importovat tělesa DWG. 
Ribbon/Pás karet > Get started/Začínáme > 
Factory Launch/Spuštění výrobní linky > 
Create Asset/Vytvořit komponentu > Import 
DWG SolidsAsset/Importovat tělesa DWG 

 

Pro přesun do kořenového adresáře 
klikněte na Workspace/Pracovní prostředí. 

Najděte složku <FDS-ROOT>\Temp a zvolte 
v ní soubor Mezzanine_Solid.dwg.  

Klikněte na tlačítko Options/Možnosti a 
zvolte možnost importu As a multi-body 
part/Jako součást s vice tělesy. Pro 
potvrzení výběru stiskněte OK. 

 

Otevřete soubor kliknutím na Open/Otevřít. 
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6. Spusťte funkci Clear/Odstranit k vymazání 
přepsání vzhledu.  
Ribbon/Pás karet > Tools/Nástroje > 
Material and Appearance/Materiál a vzhled 
> Clear/Odstranit 

 

Výběrovým oknem vyberte všechnu 
geometrii a svůj výběr potvrďte kliknutím na 
tlačítko ok.  

 

Uložte soubor  pod názvem 
<FDS-ROOT>\Layout\Mezzanine.ipt a 
zavřete ji. 

7. Otevřete soubor 
<FDS-ROOT>\Layout\Production.iam. 

8. Ujistěte se, že možnost úchopu Snap to 
Floor/přichytit k podlaze je aktivní. 
Ribbon/Pás karet > Factory > 
Options/Možnosti > Snap Types/Typy 
uchopení > Snap to Floor/Přichytit k podlaze 

9. Otevřete funkci Insert Model/Vložit model. 
Ribbon/Pás karet > Factory > Factory 
Assets/Komponenty výrobní linky > Insert 
Model/Vložit model 

 

Zvolte soubor 
<FDS-ROOT>\Layout\Mezzanine.ipt a 
umístěte mezipatro do výrobního prostoru.  

Potvrďte zarovnání kliknutím na tlačítko ok.  

 

Pro ukončení příkazu stiskněte [ESC]. 

10. Pravým tlačítkem myši otevřete kontextové 
menu a zvolte funkci 
iProperties/iVlastnosti.   
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Přepněte na panel nástrojů 
Occurrence/Výskyt a změňte X, Y a Z 
offset/Odsazení na 0. 

 

Pro potvrzení změn klikněte na OK a 
uzavřete dialogové okno.  

11. Ujistěte se, že možnost úchopu Snap to 
Surface/Přichytit k povrchu je aktivní, 
zatímco možnost Snap to Floor/Přichytit k 
podlaze je neaktivní.  

12. V uživatelském rozhranní otevřete prohlížeč 
Factory Assets/Komponenty výrobní linky. 
Ribbon/Pás karet > View/Pohled > 
Window/Okna > User Interface/Uživatelské 
rozhraní > Factory Assets/Komponenty 
výrobní linky.  

13. V prohlížeči Factory Assets/Komponenty 
výrobní linky dvojklikem zvolte 
komponentu Compressor. 
Factory Assets > Training > Process 
Equipment > Compressor 

Do mezipatra umístěte kompresor tak, jak 
ukazuje obrázek dole. 

 

14. Vložte další dva kompresory a použijte 
příkaz Align/Zarovnat pro dosažení 
rozvržení dle obrázku výše. 

15. Uložte a zavřete sestavu.
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22 Přidání podlaží 

1. Otevřete aplikaci Inventor. 

2. Otevřete soubor 
<FDS-ROOT>\Layout\Overall.iam. 

3. Použitím pohledové kostky změňte pohled 
na TOP/Shora. 

4. Otevřete funkci Create Solid Floor/Vytvořit 
těleso podlahy. 
Ribbon/Pás karet > Factory > 
Options/Možnosti > Create Solid 
Floor/Vytvořit těleso podlahy.  

 

5. Otevřete funkci Resize Floor/Změnit 
velikost podlahy. 
Ribbon/Pás karet > Factory > 
Options/Možnosti > Resize floor/Změnit 
velikost podlahy 

 

Klikněte na modrý úchopový bod ve 
spodním levém rohu podlahy. 

 

Pro hodnotu X potvrďte 5000 a pro hodnotu 
Y 5000. 

Stiskněte [ENTER]. 

Klikněte na pravý horní bod podlahy. 

Potvrďte 65000 pro hodnotu X a 40000 pro 
hodnotu Y. 

Stiskněte [ENTER]. 

6. Pravým tlačítkem myši otevřete menu 
Options/Možnosti a ukončete příkaz 
kliknutím na Done/Hotovo. 

Uložte a zavřete soubor. 
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23 Tisk v AutoCADu Architecture

1. Otevřete aplikaci AutoCAD Architecture. 

2. Otevřete soubor 
<FDS-ROOT>\Layout\Overall.dwg. 

3. Použitím View Controls přepněte pohled na 
TOP/Shora. 

4. Pomocí tlačítka Work na stavovém řádku 
otevřete pole rozvržení. 

 

5. Pravým tlačítkem myši klikněte na Quick 
View Layouts/Rychlé pohledy rozvržení a 
otevřete Page Setup Manager/Správce 
nastavení stránky.

 

Klikněte na tlačítko Modify/Upravit pro 
otevření nastavení stránky pro zvolené 
rozvržení. 

Nastavte tiskárnu na DWG To PDF.pc3, 
rozměr papíru na ISO expand A3/ISO A3 
rozšířená (297x420), Plot style 
table/Tabulka stylu vykreslování na 
None/žádné a kvalitu na 
Presentation/Prezentační. Aktivujte Plot 
transparency/Výkreslovat průhlednost, 
deaktivujte Plot object 
lineweights/Vykreslovat tloušťku čar. 

Pro potvrzení změn klikněte na Ok a zavřete 
Page Setup Manager/Správce nastavení 
stránky  kliknutím na Close/Zavřít. 

 

6. Otevřete funkci New/Nový. 
Ribbon/Pás karet: iView/Zobrazit > 
Viewports/Výřezy > New/Nový 

 

V dialogovém okně Viewports/Výřezy 
vyberte nastavení Three: Right/ Tři: Vpravo 
a dialogové okno zavřete kliknutím na OK. 

 

Klikněte pravým tlačítkem myši pro otevření 
menu Options/Možnosti a zvolte možnost 
Fit/Max pro umístění. 

7. Dvojklikem uvnitř vnitřního pole aktivujte 
horní levy výřez. Aktivovaný výřez se zobrazí 
tučnějším orámováním.  
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8. Nastavte měřítko výřezu na 1:500. 

 

9. Podržte stisknuté prostřední tlačítko myši a 
přemístěte budovu do středu pohledu. 

 

10. Uzamkněte zvolený pohled kliknutím na 
Lock/Unlock 
Viewport/Odemknout/Zamknout výřez na 
stavovém řádku.  

 

11. Otevřete Layer Properties Manager. 
Ribbon/Pás karet: Home/Výchozí > 
Layer/Hladiny > Layer Properties/Vlastnosti 
hladiny 

Není-li zobrazeno pole Layer Filters/Filtry, 
otevřete jej. 

 

Pravým tlačítkem myši klikněte na nejvyšší 
úroveň All/Vše a pomocí funkce 

Viewport/Výřez > Freeze/Zmrazit zmrazte 
všechny vrtsvy v aktuálním výřezu.  

 

Kliknutím na symbol VP Freeze/Zmrazit ve 
výřezu rozmrazte vrstvu 0.  

 

Zvolte referenci Building v okně filtrů a 
rozmrazte vrstvy A_Glaz, S_Cols, A_Door a 
A_Wall. 

 

Zvolený výřez nyní ukazuje pouze vnější zdi 
a sloupy.  

 

12. Otevřete dialogové okno Options/Možnosti. 
Menu browser/Menu aplikace > 
Options/Možnosti 

Přepněte na panel nástrojů AEC 
Dimension/Kóta AEC, změňte jednotky na 
Inches/Palce a dialogové okno zavřete 
stisknutím OK. 
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13. Otevřete funkci AEC-Dimension 
Exterior/Kóta AEC venkovní. 
Ribbon/Pás karet: Annotate/Poznámka > 
Dimensions/Kóty > Dimensions 
Flyout/Rozbalovací nabídka > AEC-
Dimension Exterior/Kóta AEC venkovní.  

 

Klikněte pravým tlačítkem myši pro otevření 
kontextového menu a zvolte možnost Pick 
points/Vybrat bod. 

Klikněte na levý spodní a pravý horní roh 
budovy a ukončete výběr stisknutím klávesy 
[ENTER]. 

 

Umístetěte kótu na levou stranu vnější zdi. 

14. Obdobně vytvořte druhou kótu pro horní 
vodorovnou vnější zeď. 

15. Vyberte vytvořenou kótu. 

Otevřete příkaz Add Extension Lines/Přidat 
vynášecí čáry. 
Ribbon/Pás karet: AEC Dimension/Kóta 
AEC/ > Modify/Upravit > Add Extension 
Lines/Přidat vynášecí čáry 

 

Klikněte na počáteční a koncový bod 
horního otvoru a ukončete výběr stisknutím 
[ENTER]. 

Vyberte dříve vytvořenou kótu. 

16. Samostatně vytvořte kóty pro středovou 
vodorovnou řadu sloupů. Nejprve se však 
ujistěte, že možnost úchopu 
Midpoint/Polovina je aktivní. 

 

17. Dvojklikem uvnitř pole aktivujte spodní levý 
výřez.  

18. Použitím View Controls/Ovládací prvky 
stylu zobrazení přepněte pohled na SW 
Isometric/SW Iso a změňte styl zobrazení 
na Conceptional/Koncepční. 

 

19. Přibližte si pohled tak, že zobrazené objekty 
hodně vyplňují celý výřez.  

20. Otevřete Layers Properties 
Manager/Správce vlastností hladiny. 

Klikněte na hodnotu 
Transparency/Průhlednost vrstvy 
Building|A_Roof a do dialogového okna 
Layer Transparency/Průhlednost hladin 
zadejte hodnotu 70. 
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Pro potvrzení změn klikněte na OK. 

 

21. Uzamkněte pohled. 

22. Deaktivujte výřez dvojklikem mimo něj.  

Budova je nyní zobrazena s poloprůhlednou 
střechou ve vybraném výřezu.  

 

23. Dvojklikem uvnitř oblasti aktivujte pravý 
výřez.  

24. Nastavte měřítko výřezu na 1:75. 

25. Přibližte si pohled tak, že oblast kanceláří 
uvnitř budovy je umístěna ve středu 
pohledu. 

26. V aktuálním pohledovém okně zmrazte 
vrstvy Building|A_Aisles, Building|A_Roof, 
Building|S_Grid a Building|S_Beam. 

27. Otevřete funkci AEC-Dimension 
Exterior/Kóta AEC venkovní. 

Zvolte levou svislou zeď a umístěte kótu na 
její levou stranu. 

28. Zvolte vytvořenou kótu. 

Každá vynášecí čára obsahuje symbol 
mínus. Tento symbol může být využit pro 
odstranění konkrétní vynášecí čáry.   

 

Kliknutím na symbol mínus odstraňte část 
vynášecích čar a ponechte pouze ty, které 
jsou požadovány pro zakótování obrysů.  

 

29. Přidejte jakékoliv další kóty dle vlastního 
uvážení.   

30. Zamkněte pohled. 

31. Otevřete příkaz Plot/Vykreslit. 
Quick Access Toolbox/Panel rychlého 
přístupu > Plot/Vykreslit.  

 

Dialogové okno Plot/Vykerslování 
zobrazuje všechna nastavení učiněná v 
nastavení stránky. Další úpravy nejsou 
nutné. 

Pro zahájení vykreslování stiskněte OK. 

32. Uložte soubor pod názvem 
<FDS-ROOT>\Temp\Overall.pdf. 

33. Zkontrolujte výsledek v prohlížeči PDF 
souborů.  

34. Uložte a poté zavřete výkres.
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24 Vytvoření a nastavení výkresu v Inventoru

1. Otevřete aplikaci Inventor. 

2. Vytvořte nový soubor. 
Application Menu/Menu aplikace > New/Nový 
>New/Nový 

 

Ze seznamu metrických šablon zvolte DIN.idw. 

 

3. Uložte soubor pod názvem 
<FDS-ROOT>\Layout\Mezzanine.idw. 

4. V prohlížeči klikněte pravým tlačítkem myši na 
Sheet: 1/List:1 a zvolte Edit sheet/Upravit 
list… 

 

Změňte velikost formátu papíru na A3 a pro 
potvrzení změn klikněte na OK  

 

5. Otevřete funkci Base/Základní pohled. 
Ribbon/Pás karet: Place Views/Umístění 
pohledů > Create/Vytvořit > Base/Základní 
pohled.  

 

6. Zvolte soubor 
<FDS-Root>\Layout\Production.iam. 

 

Zvolte orientaci Top/Horní. 

 



 

  70 

Zvolte měřítko 1/100 a deaktivujte možnost 
vytvoření promítnutého pohledu.  

 

Ponechte dialogové okno otevřené a umístěte 
model kliknutím na výkres. 

7. Otevřete příkaz Crop/oříznutí. 
Ribbon/Pás karet: Place Views/Umístění 
pohledů > Modify/Upravit > Crop/Oříznutí 

 

Použitím červeně tečkovaného rámečku 
vyberte umístěný pohled.  

Použitím výběrového okna vyberte oblast pro 
oříznutí kliknutím na body dle obrázku níže.  

 

 

8. Klikněte na rámeček oříznutého pohledu, 
podržte stisknuté tlačítko myši a přemístěte 
pohled do spodního levého rohu listu. 

 

9. Otevřete funkci Section/ Řez. 
Ribbon/Pás karet: Place Views/Umístění 
pohledů > Create/Vytvořit > Section/Řez 

 

Pomocí rámečku vyberte pohled. 

Zadejte počáteční a koncový bod čáry řezu. 
Ujistěte se, že body jsou vně ráměčku výkresu. 

 

Klikněte pravým tlačítkem myši a vyberte 
možnost Continue/Pokračovat. 

Deaktivujte možnost Toggle Label 
Visibility/Přepnout viditelnost popisku. 

 

Ponechte dialogové okno otevřené a umístěte 
nový pohled přes již existující. 

Pravým tlačítkem myši klikněte na čáru řezu, 
zvolte možnost Reverse Direction/Obrátit 
směr a deaktivujte možnost Show Entire 
Line/Zobrazit celou čáru. 

10. Otevřete funkci Projected/Promítnutý. 
Ribbon/Pás karet: Place Views/Umístění 
pohledů > Create/Vytvořit > 
Projected/Promítnutý.  
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Pomocí rámečku zvolte levý horní pohled řezu 
a přidejte nový pohled horizontálně doprava. 

 

Klikněte pravým tkačítkem myši a zvolte 
možnost Create/Vytvořit. 

11. Otevřete funkci Dimension/Kóta. 
Ribbon/Pás karet: Annotate/Poznámka 
>Dimension/Kóta > Dimension/Kóta 

 

V levém horním zobrazení řezu nejprve 
klikněte na spodní konec pravého vnějšího 
sloupu a poté na horní okraj mezipatra. 

Táhněte kótu doprava, dokud nezapadne, a 
poté ji umístěte. 

 

V otevřeném dialogovém okně Edit 
Dimension/Upravit kótu deaktivujte možnost 
Edit Dimension when created/Upravit kótu po 
vytvoření a stiskněte OK. 

 

Pro vytvoření druhé kóty nejprve klikněte na 
horní okraj mezipatra a poté do středu 
zábradlí. 

Umístěte kótu tak, jak je popsáno výše. 

Pro ukončení příkazu Dimension/Kóta 
stiskněte [ESC]. 

 

Použitím myši táhněte horní kótu nahoru 
doprava. 

 

Obdobným způsobem zakótujte vnější obrysy 
mezipatra v pohledu shora.  

Jako referenční body kót volte středy zábradlí. 
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12. Otevřete funkci Auto Balloon/Automatické 
pozice. 
Ribbon/Pás karet: Annotate/Poznámka > 
Table/Tabulka > Auto Balloon/Automatické 
pozice. 

 

Použitím červeného tečkovaného rámečku 
vyberte pravý horní pohled. 

 

Výběrovým obdélníkem z horního levého do 
pravého spodního rohu vyberte všechny 
komponenty pod mezipatrem, jak je ukázáno 
na obrázku níže.  

 

V dialogovém okně Auto Balloon/Automatické 
pozice nastavte BOM view/Zobrazení rozpisky 
na Parts Only/Poue součásti a klikněte na 
tlačítko Select placement/Vybrat umístění. 

 

Pozice umístěte pod pohled.  

V dialogovém okně Auto Balloon/Automatické 
pozice klikněte na  OK pro potvrzení. 

Na dotaz ohledně povolení rozpisky klikněte na 
OK.  

13. Otevřete funkci Parts List/Kusovník. 
Ribbon/Pás karet: Annotate/Poznámka > 
Table/Tabulka > Parts List/Kusovník.  

 

Pomocí červeného tečkovaného rámečku 
vyberte horní pravý pohled. 

V dialogovém okně Parts List/Kusovník 
klikněte na OK a umístěte seznam do 
kteréhokoliv bodu vně rámečku výkresu. 

Dvojklikem na kusovník otevřete funkci pro 
jeho editaci. 

Klikněte na Filter Settings/nastavení filtru. 

Vyberte filtr Ballooned Items Only/Pouze 
položky s pozicí a pro potvrzení klikněte na 
tlačítko se zelenou fajfkou.  

 

Pro uzavření obou dialogových oken klikněte 
na OK. 

14. Umístěte kurzor myši nad jakýkoliv text v 
kusovníku, dokud není vedle kurzoru zobrazena 
všesměrová šipka.  

Táhněte kusovník a umístěte jej nad popisové 
pole. 

 

Pokud je to nezbytné, upravte šířku sloupců 
pomocí tažení jejich hraničních úseček myší.  

15. Uložte a zavřete soubor. 
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25 3ds Max – Import dat a jejich přizpůsobení 

1. Spusťte aplikaci 3ds Max.  

2. V menu Import otevřete dialogové okno 

Import. 

Application menu > Import > Import 

 

Zvolte soubor 

<FDS-ROOT>/Layout/Production.iam.  

V následujícím dialogovém okně zvolte 

možnost importu Meshes a ujistěte se, že 

Vertical Direction – vertikální směr je 

nastaven na osu Z - Z Axis. 

 

 

Pro zahájení importu klikněte na OK. 

Poznámka: Import může trvat několik 
minut. 

3. Pomocí výběrového okna kolem celé 

konstrukce vyberte všechny objekty. 
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4. Spusťte funkci Ungroup. 

Ribbon: Group > Ungroup 

 

5. Uložte model pod názvem 

<FDS-ROOT>\3dsMax\Production.max. 

6. Otevřete okno Units Setup. 

Ribbon: Customize>Units Setup 

 

Nastavte jednotky na Metric > Millimeters. 

Klikněte na tlačítko System Unit Setup. 

 

Nastavte měřítko tak, aby 1 unit = 1.0 
millimeters.  

 

Pro potvrzení všech změn klikněte na OK. 

7.  Na stavovém řádku ve spodní části 

obrazovky otevřete Time Configuration. 

 

Nastavte Frame rate na Custom - 25 FPS a 
animation End Time na 250. Pro potvrzení 
změn klikněte na OK. 

 

8. Otevřete okno Render Setup. 

Main toolbar> Render Setup 
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Ujistěte se, že Area to Render je nastavena 
na View a hodnoty pro Output Size jsou 
zadány pro width na 640px a pro height na 
480px. 

 

9. Přejděte na panel nástrojů Indirect 

Illumination. 

Deaktivujte možnost Enable Final Gather. 

 

Dialogové okno zavřete. 

Otevřete okno nastavení Environment. 
Ribbon/Pás karet: Rendering>Environment 

 

Klikněte na tlačítko None a dvojklikem 
vyberte  Gradient. 

 

Zavřete dialogové okno.
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26 3dsMax – Další možnosti modifikace

1. Zobrazte všechny čtyři okna kliknutím na 

tlačítko Maximize Viewport Toggle na 

stavovém řádku ve spodní části 

obrazovky. 

 

Klikněte uvnitř okna, které je ukázáno na 
obrázku výše. Obrysy okna budou 
zvýrazněny žlutě. 

 

Maximalizujte vybrané okno opětovným 
kliknutím na tlačítko Maximize Viewport 
Toggle. 

2. Oddalte pohled tak, aby jste viděli celý 

výkres. 

3. Z panelu Command Panel na pravém 

okraji obrazovky otevřete funkci Box. 

Create panel> Geometry> Standard 
Primitives> Object Typerollout >Box 
button 

 

Pomocí výběrového obdélníku vyberte 
všechny elementy v okně.  

4. V panelu Command Panel změňte 

parametry pro box: 

 délka: 50000.00 mm 

 šířka: 70000.00 mm 

 výška: -120.00 mm 

5. Vraťte se na pohled se 4 okny.  

Podržte stisknutý kurzor na tlačítku 

Material Editor po tu dobu, dokud se 

neobjeví rozbalovací menu. Nyní 

umístěte kurzor na prostřední tlačítko a 

otevřete Material Editor (Compact). 

Main toolbar> Material Editor Flyout> 
Material Editor (Compact) 

 

6. Dvojklikem vyberte 02 – Default. Otevře 

se okno náhledu.  

 

7. V Material Editor klikněte na prázdné 

tlačítko vedle pole barev pro Diffuse. 

Dvojklikem vyberte Tiles. 

 

8. V rozbalovacím menu Coordinates 

zaklikněte Use Real-World Scale a 

změňte tile scale na U: 5.0 a V: 3.0. 
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9. Rozbalte Advanced Controls. 

Klikněte na barevné pole vedle Texture v 
sekci Tiles Setup. Změňte barvu na White 
(bílou) (255,255,255) a pro potvrzení 
změn klikněte na OK. 

Stejným způsobem změňte barvu Texture 
v Grout Setup na Gray (šedou) 
(100,100,100). 

Ujistěte se, že horizontální a vertikální 
gap/mezera je nastavena na 0.5. 

 

Klikněte na tlačítko Go to Parent pro 

návrat do nejbližší vyšší úrovně pro 

editaci material.  

 

V sekci Reflection změňte parametr 
Reflectivity  na 0.3. 

 

10. V popisovém poli pojmenujte materiál 

floor. 

 

Zavřete Material Editor. 

11. Maximalizujte spodní levé okno, které 

ukazuje bokorys modelu. 

Vyberte podlahovou desku. 

Otevřete Modify Panel v panelu 
Command Panel na pravém okraji 
obrazovky. 

Z Modifier list vyberte vstup UVW-Map.  

 

Deaktivujte možnost Real-World Map 
Size. 

 

12. Znovu otevřete Material Editor 

(Compact). 

Ujistěte se, že je zvolen vzor floor a 
klikněte na tlačítko Assign Material to 
Selection. 

 

Zavřete Material Editor. 

13. Otevřete funkci Rendering. 

Main toolbar> Render Production) 
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Zavřete rendrování. 

14. Změňte pohled na 4 okna. 

Ujistěte se, že vidíte celý model ve všech 
zobrazovacích oknech. 

15. Nyní zvolte horní pravé okno, které 

ukazuje nárys modelu. 

Oddalte pohled tak, aby podlahová deska 
zabírala zhruba jednu třetinu šířky 
zobrazovacího pole. 

Umístěte model do spodního okraje okna.  

16. V panelu Command Panel na pravém 

okraji obrazovky otevřete funkci Target 

Spot. 

Create panel>Lights> Standard > Rollout 
Object Type>Target Spot button  

 

Umístěte světlo v horní pravé části 
modelu. Podržte stisknutý kurzor a 
táhněte světelný kužel dolů tak, že 
pokrývá model ve všech pohledech. 

 

Rozbalte Shadow Parameters a nastavte  
Object Shadows Density na 0.65. 

 

Stiskněte [ESC] pro dokončení vytváření 
světel. 

 

Vraťte se na pohled se 4 okny.  
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27 3ds Max –Animace a rendrování 

1. Maximalizujte levé horní okno s 
půdorysem modelu. 

2. Přibližte si oblast s malým dopravním 

pásem ve tvaru L. 

Podržte stisknutou klávesu [CTRL] a 
vyberte všechny čtyři části dopravního 
pásu. 

3. Pravým tlačítkem myši klikněte na 

dopravní pás a vyberte možnost Hide 

Unselected. 

 

4. V panelu Command Panel otevřete funkci 

Box a umístěte box vedle dopravního 

pásu.  

Pro box zadejte následující rozměry: 

 Délka: 500.00mm 

 Šířka: 500.00mm 

 Výška: 250.00mm 

5. V Command Panel otevřete funkci Line. 

Create panel > Shapes > Splines > Object 
Type Rollout > Line button 

 

Podržte stisknutou klávesu [SHIFT] a 
kreslete úsečky pomocí tří zvolených 
bodů podél dopravního pásu tak, jak je 
ukázáno na obrázku dole. 

 

Klikněte pravým tlačítkem myši pro 
ukončení příkazu. 

Na Control Panel na pravém okraji 
obrazovky  přejmenujte úsečku na Path1. 
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6. Znovu vyberte všechny části dopravního 

pásu a ujistěte se, že není zvolena i 

vytvořená úsečka.  

Pravým tlačítkem myši klikněte na 
dopravní pás a zvolte možnost Hide 
Selection. 

Vyberte vytvořenou úsečku.  

Na Command Panel na pravém okraji 
obrazovky otevřete Modify Panel. 

 Na Modifier List zvolte  Vertex. 

 

Vyberte rohový bod. 

V Command Panel změňte parametr 
Fillet na 1,200.00mm. 

 

7. Pravým tlačítkem myši klikněte uvnitř 

modelu a zvolte možnost Unhide by 

Name. 

Podržte stisknutou klávesu [CTRL] a z listu 
vyberte všechny Straight Roller 
Conveyors a Horizontally Curved Roller 
conveyors. Poté klikněte na tlačítko 
Unhide. 

8. Změňte pohled na 4 okna a maximalizujte 

pravé horní okno, které ukazuje nárys 

modelu. 

Přibližte si oblast levého dopravního 
pásu. 

9. Otevřete funkci Select and Move. 

Main toolbar > Select and Moved 

 

Zvolte Path1 a táhněte ji na vrchol 
dopravního pásu. 

10. Změňte pohled zpět na  4 okna. 

11. Maximalizujte spodní pravé okno, které 

ukazuje perspektivní pohled na model. 

12. Vyberte vytvořený box. 

Otevřete Motion Panel na Command 
Panel na pravém okraji obrazovky.   

Rozbalte Assign Controller, zvýrazněte 
Position:Position-XYZ ze stromu a 
klikněte na tlačítko Assign Controller. 

 

Z listu vyberte Path Constraint a klikněte 
na OK. 

Klikněte na tlačítko Add Path na panelu 
Command Panel. 
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Zvýrazněte Path1.  

Trasa bude nyní vypsána v seznamu pod 
tlačítkem.  

Na panelu Command Panel změňte 
parametr % Along Path na 1.0. 

 

13. Vyberte box. 

Aktivujte možnost AutoKey na stavovém 
řádku ve spodním okraji obrazovky.  

 

Změňte polohu posuvníku na 250/250. 

 

Na Command Panel změňte parametr % 
Along Path na 100. 

Deaktivujte možnost Auto-Key a vraťte 
posuvník zpět na výchozí polohu 0/250.  

14. Přehrajte zpátky animaci použitím 

ovládacích tlačítek na stavovém řádku. 

 

15. Pravým tlačítkem myši klikněte uvnitř 

modelu a vyberte možnost Unhide All. 

Vraťte se na pohled se 4 okny a aktivujte 
levé horní (pohled shora). 

16. V Command Panel na pravém okraji 

obrazovky otevřete Create Panel. 

Otevřete funkci Free camera. 

Create panel>Cameras > Standard > 
Object Type Rollout > Free button  

 

Umístěte kameru do středu nad model. 

Stiskněte [ESC] pro ukončení funkce. 

17. Aktivujte spodní pravé okno 

(Perspektiva). 

Použitím View Controls (levý horní roh 
modelového pole) změňte pohled na 
Cameras > Camera001. 

 

18. Aktivujte spodní levé okno (pohled z 

boku). 

Otevřete funkci Select and Move. 
Main toolbar>Select and Move 

Vyberte kameru a umístěte ji tak, jak 
ukazuje obrázek dole. 
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19. Otevřete funkci Select and Rotate. 

Main toolbar>Select and Rotate 

V horním pravém okně (nárys) uchopte 
vnější prstenec kamery a táhněte 
kurzorem pryč od kamery, dokud objektiv 
kamery nemíří vzhůru. 

 

Ve spodním levém zobrazovacím poli 
(bokorys) uchopte vnější prstenec kamery 
a táhněte kurzorem pryč od kamery, 
dokud objektiv kamery nemíří k podlaze 
pod úhlem 45.00°. 

 

Dopravní pás s boxem by nyní měl být v 
objektivu kamery. 

Pro získání lepšího pohledu na dopravní 
pás pokračujte s úpravou umístění 
kamery použítím výše uvedených příkazů. 

 

20. Aktivujte spodní pravé okno.  

21. Otevřete Render Setup. 

Ribbon: Rendering> Render Setup 

Nastavte Time Output na Active Time 
Segment. 

 

Klikněte na tlačítko Files uvnitř oblasti 
Render Output.  

 

Otevřete složku <FDS-ROOT>/3dsMax, 
potvrďte demo_movie jako název 
souboru, zvolte AVI File jako typ soubor a 
klikněte na tlačítko Save. 

22. V otevřeném dialogovém okně klikněte 

na OK pro potvrzení výchozího nastavení 

komprese.  

Klikněte na tlačítko Render pro zahájení 
rendrování.  

Rendrování může v závislosti na výkonu 

počítače trvat od několika minut až po 

několik hodin.  
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28 Navisworks – Navigace a pohledy 

1. Otevřete aplikaci Navisworks. 

2. Otevřete dialogové okno Options. 

Application Menu > Options 

Zruště následující možnosti a pro potvrzení 
změn klikněte na OK.  

 

 

3. Otevřete funkci Append. 

Ribbon: Home > Project > Append Flyout> 
Append 

 

4. Změňte typ souboru na All Files (*.*) a 

zvolte soubor 

<FDS-ROOT>\Layout\Overall.dwg. 

5. Obdobně přidejte soubor 

<FDS-ROOT>\Layout\Overall.iam. 

6. Použitím pohledové kostky změňte pohled 

na Home. 

 

Kliknutím vyberte střechu a skryjte ji 
stisknutím kombinace kláves [Ctrl]+[H]. 

7. Pravým tlačítkem myši klikněte na pozadí a 

zvolte možnost Background. 

 

Změňte způsob na Graduated a dialogové 
okno uzavřete kliknutím na OK. 

 

8. Podržte stisknuté prostřední tlačítko myši a 

nastavte pohled tak, aby byl model ve 

středu.  

Pokud je to potřebné, použijte rolování 

kolečkem myši pro zvětšení či zmenšení 

pohledu. 
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Otevřete funkci Save Viewpoint. 
Ribbon: Viewpoint > Save, Load and 
Playback > Save Viewpoint Flyout> Save 
Viewpoint 

 

Potvrďte název Total view a stiskněte 
[ENTER]. 

 

9. Použitím pohledové kostky změňte pohled 

na RIGHT. 

Přibližte si pohled tak, aby kamera byla 
umístěna nad rovinou. 

10. V navigačním řádku změňte na Walk. 

Navigation bar > Walk Flyout> Walk 

 

Klikněte na rozbalovací menu pod 
symbolem kroků. 

Zvolte možnosti Collision a Gravity. 

 

Nastavte vhodný úhel pohledu otočením 
kolečka myši. 

11. Použitím kurzoru táhněte pro naznačení 

pohybu a držte kurzor stisknutý. 

 

Pohněte kurzorem směrem ke vstupnímu 
otvoru a zůstaňte stát ve vstupu. 

 

Uložte pohled pod názvem Camera1. 

12. Otevřete funkci Plan View. 

Ribbon: View > Navigation Aids > reference 
View Flyout> Plan View 

 

Pohybujte se skrz budovu podél naznačené 
cesty a vytvořte pohledy označené čísly 2-7. 
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13. Pro aktivování klikněte na pohled Camera7. 

14. Použitím navigačního panelu změňte na 

Orbit. 

Navigation Bar > Orbit Flyout> Orbit 

 

 

 

Stiskněte kombinaci kláves 
Ctrl]+[Shift]+prostřední tlačítko myši a 
nastavte orbit orientačně do středu 
komponenty turn table. 

Otočte pohledem tak, že se díváte směrem 
dolů na komponentu turn table. 

 

Pravým tlačítkem myši klikněte na Camera7 
a zvolte funkci Update. 

 

Otočte pohled proti směru hodinových 
ručiček o 90 stupňů a vytvořte poslední 
pohled Camera8. 

15. Pravým tlačítkem myši klikněte uvnitř okna 

Saved Viewpoints a zvolte Add Animation. 

 

Vyberte pohledy Camera1 až Camera8 a 
přetáhněte je do animace. 

 

16. Pravým tlačítkem myši klikněte na 

Animation a zvolte funkci Edit. 

Nastavte délku animace na 30 sekund a 
stiskněte OK. 

 

17. Otevřete funkci Play.  
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Ribbon: Viewpoint > Save, Load and 
Playback > Play 

 

18. Pro aktivování klikněte na pohled Camera1.  

Ujistěte se, že způsob navigace je nastaven 
na Walk. 

Klikněte na rozbalovací menu pod 
symbolem chůze. 

Zvolte možnost Third Person. 

 

Uložte pohled pod názvem ThirdPerson. 

Pravým tlačítkem klikněte na ThirdPerson a 
zvolte možnost Edit. 

 

V otevřeném dialogovém okně klikněte na 
Settings. 

V dialogovém okně Collision vyberte Avatar 
Human 1 a uzavřete obě dialogová okna 
kliknutím na OK. 

 

Projděte budovu s avatarem a vyzkoušejte 
schody do mezipatra. 

19. Uložte aktuální záběr pod názvem souboru 

<FDS-ROOT>\Navisworks\Overall.nwf. 
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29 Navisworks – Řezy a prezentace 

1. Otevřete aplikaci Navisworks. 

2. Otevřete soubor 

<FDS-Root>\Navisworks\Overall.nwf . 

3. Otevřete okno Saved Viewpoints. 

Ribbon: View > Workspace > Window 
Flyout> Saved Viewpoints 

 

Aktivujte pohled Totalview. 

4. Otevřete funkci Append a zvolte soubor 

<FDS-ROOT>\Navisworks\CNC-

Station.nwd. 

5. V navigačním panelu změňte na Orbit. 

Změňte styl renderu na Wireframe. 
Ribbon: Viewpoint > Render Style > Mode 
Flyout> Wireframe 

 

Pravým tlačítkem myši klikněte na pozadí 
a nastavte pohled na Look From Top. 

 
6. Nastavte pohled kamery na 

Orthographic. 

Ribbon: Viewpoint > Camera > 
Perspective Flyout> Orthographic 

 
7. Otevřete okno Selection Tree. 

Ribbon: Home > Select & Search > 
Selection Tree 

 

Zvolte položku CNC-Station.nwd. 

Otevřete funkci Move. 
Ribbon: Item Tools > Transform > Move 
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Přemístěte zvolené mračno bodů do 
čtverce mřížky 2A. 

 

Otevřete funkci Rotate. 
Ribbon: Item Tools > Transform > Rotate 

 

Rozbalte další možnosti menu Transform. 

Nastavte 90 stupňů jako rotaci kolem osy 
Z. Pro potvrzení změn stiskněte [ENTER]. 

 

Znovu otevřete funkci Move a přemístěte 
mračno bodů na vnější zeď. 

 

Pro ukončení výběru stiskněte [ESC]. 

Nastavte styl renderu na Shaded. 

8. Aktivujte pohled Camera4 a 

prozkoumejte model. 

9. Aktivujte pohled Totalview a 

prozkoumejte model. 

10. Přibližte si oblast mezipatra. 

Otevřete funkci Enable Sectioning. 
Ribbon: Viewpoint > Sectioning > Enable 
Sectioning 

 

Klikněte na symbol žárovky a aktivujte 
výběr Plane 1. 
Ribbon: Sectioning tools > Planes Settings 
> Current: Plane 1 

 

Pomocí šipek přemístěte vybranou rovinu 
tak, že horní část budovy je seříznuta a 
kompresory jsou kompletně viditelné. 

 

Dodatečně aktivujte plane 3 a přemístěte 
ji tak, aby byla seříznuta oblast před 
mezipatrem.  
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Nakonec zvolte rovinu plane 2, ale 
neaktivujte ji. 

V důsledku toho nebudou roviny 1 a 3 
zobrazeny. 

Uložte pohled kamery pod názvem 
Mezzanine. 
Ribbon: Sectioning Tools > Save > Save 
Viewpoint 

11. Otevřete okno Sets. 

Ribbon: Home > Select & Search > Sets 
Flyout> Manage Sets… 

 

Klikněte na New Folder a pojmenujte 
složku jako Mezzanine. 

 

Ze tří kompresorů klikněte pravým 
tlačítkem na kompresor nejvíc vpravo. 

Z kontextového menu zvolte možnost Set 
Selection Resolution To Last Object.  

 

Podržte stisknutou klávesu [CTRL] a 
pravým tlačítkem myši vyberte všechny 
tři kompresory. 

 

Uložte výběr kliknutím na Save Selection 
v okně Sets a výběr pojmenujte 
Compressors. 

 

Přesuňte nový soubor do složky 
Mezzanine. 

 

Aktivujte funkci Select. 
Ribbon: Home > Select & Search > Select 
Flyout> Select 

 

Použitím možnosti Set Selection 
Resolution to Geometry vyberte všechna 
zábradlí  mezipatra a výběr uložte pod 
názvem Railing a přesuňte jej do složky 
Mezzanine. 
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12. Pravým tlačítkem myši klikněte na složku 

Mezzanine a zvolte možnost Hide. 

 
13. Otevřete funkci Measure Area. 

Ribbon: Review > Measure > Measure 
Flyout> Area 

 

Postupně klikněte na šest rohových bodů 
mezipatra. Je-li to nutné, jednotlivé 
rohové body si přibližte. 

Ujistěte se, že máte zvolený pohled 
kamery Mezzanine. 

Otevřete funkci Convert to Redline. 
Ribbon: Review > Measure > Convert to 
Redline 

 

14. Pravým tlačítkem myši klikněte na složku 

Mezzanine a zvolte možnost Unhide. 

Zvolte soubor Compressors. 

Změňte hodnotu  Transparency na 80% a 
stiskněte [ENTER]. 
Ribbon: Item Tools > Appearance > 
Transparency 

 

 Pro ukončení výběru stiskněte [ESC]. 

15. Pravým tlačítkem myši klikněte na 

hodnotu rozlohy a vyberte funkci Move. 

Kliknutím zvolte vhodné umístění kóty.  

 
16. Otevřete funkci Image. 

Ribbon: Output > Visuals > Image 
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Zvolte PNG jako Output format, Viewport 
jako Renderer a Explicit jako Size type s 
šířkou 1024 a výškou 768. Nastavte Anti-
aliasing na 4x. Pro potvrzení změn 
klikněte na OK. 

 

Uložte obrázek pod názvem 
<FDS-ROOT>\Navisworks\Mezzanine.pn
g. 

17. Nastavte  Transparency Compressors na 

0%. 

18. Otevřete funkci Animation. 

Ribbon: Output > Visuals > Animation 

 

 Zvolte Current Animation jako Source, 
Viewport jako Renderer, Windows AVI 
jako Output format a Explicit jako Size 
type s šířkou 1024 a výškou 768. Nastavte 
FPS (snímků za sekundu) na 25 a Anti-
aliasing – potlačení roztřepení okrajů na 
4x. Pro potvrzení klikněte na OK. 

 

 

 

Uložte video pod názvem 
<FDS-ROOT>\Navisworks\Overall.avi. 

19. Otevřete funkci FBX. 

Ribbon: Output > Export Scene > FBX 

 

V dialogovém okně FBX Options přepněte 
jednotky na Millimeters a pro potvrzení 
změn klikněte na OK. 

 

Uložte model pod názvem  
<FDS-ROOT>\Navisworks\Overall.fbx. 

20. Uložte projekt  Navisworks pod názvem 

<FDS-ROOT>\Naviswork\Overall.nwf. 
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30 Showcase – Import dat, alternativy a animace 

1. Otevřete aplikaci Navisworks. 

2. Spusťte funkci Append. 

Zvolte soubor 
<FDS-ROOT>\Layout\Production.iam. 

3. Otevřete dialogové okno File Options. 

Ribbon: Home > Project > File Options 

 

Aktivujte panel Orientation a nastavte na 
X=0, Y=0, Z=1 pro UP a X=0, Y=1, Z=0 pro 
North. 

Pro potvrzení změn stiskněte OK. 

 

4. Použitím pohledové kostky změňte pohled 

na Top. 

Spusťte funkci Select Box. 
Ribbon: Home > Select & Search > Select 
Flyout> Select Box 

 

Zvolte část výrobní zóny tak, jak je ukázáno 
dole na obrázku. 

 
Spusťte funkci Hide Unselected. 
Ribbon: Home > Visibility > Hide Unselected 

 
5. Spusťte funkci FBX. 

Ribbon: Output > Export Scene > FBX 

 

Jako Convert units to zvolte Millimeter a 
kliknutím na OK potvrďte změny. 

 

Uložte model pod názvem  
<FDS-ROOT>\Showcase\Production.fbx. 
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6. Otevřete aplikaci Showcase. 

Pro zobrazení menu klikněte na šipku na 
horním okraji obrazovky. 

 
7. Otevřete funkci Import. 

Menu: File > Import > Import File(s) 

 

Zvolte soubor 
<FDS-ROOT>\Showcase\Production.fbx. 

Po úspěšném importu souboru klikněte na 
Close pro uzavření okna Import status, je-li  
stále zobrazeno.  

8. V navigační řádku změňtě na Orbit. 

Navigation Bar > Orbit Flyout> Orbit 

 

Podržte stisknuté klávesy [Ctrl]+[ALT]  a 
kurzorem resetujte osu otáčení tak, jak je 
vyžadováno. 

9. Stiskněte klávesu [V] pro zobrazení 

uživatelského rozhranní Visual Styles. 

Zvolte Shadows jako styl zobrazení. 

 

K uzavření uživatelského rozhraní 
Visual Styles znovu stiskněte klávesu [V]. 

10. Použitím pohledové kostky změňte pohled 
na Top. 

 

Stiskněte klávesu [A] pro zobrazení 
uživatelského rozhraní Alternative Lineups. 

Vytvořte nový Positional Lineup. 
User Interface: Alternative Lineups > Create 
Flyout> Positional Lineup 

 

Zvolte stroj a pracovníka jako na obrázku 
dole. 

 
Stiskněte tlačítko Add Alternatives. 

Dvojklikem vyberte název pole a editujte 
ho. Potvrďte název Position 1. 

Pro potvrzení stiskněte [ENTER]. 

 

Stiskněte klávesu [H] pro zobrazení 
Transform Handles. 
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Použitím zelené, modné a červené šipky 
přemístěte a otočte zvolené objekty tak, jak 
je ukázáno na obrázku dole. 

 

Vytvořte novou možnost a pojmenujte ji 
Position 2. 

 

K uzavření uživatelského rozhraní 
Transform Handles znovu stiskněte klávesu 
[H]. 

K uzavření uživatelského rozhraní 
Alternative Lineups znovu stiskněte klávesu 
[A]. 

11. Rolováním kolečka myši si přibližte oblast 

robotického systému.  

 

Stiskněte klávesu [B] pro zobrazení 
uživatelského rozhraní Behaviors. 

Zvolte šedou základovou desku komponenty 
turntable. 

Vytvořte novou animaci typu Turntable. 
User Interface: Behaviors > Create Flyout> 
Turntable

 

V okně vlastností Turntable Properties, 
klikněte na tlačítko Move pivot to objects. 

 

Podržte stisknutou klávesu [SHIFT] a pravým 
tlačítkem myši současně klikněte na levou 
horní komponentu fixture. 

V kontextovém menu zvolte možnost Turn 
Table Fixture:1. 

 

Obdobným způsobem zvolte další dvě 
komponenty turntable fixture. 

V dialogovém okně Turntable Properties 
klikněte na tlačítko Choose a zvolte možnost 
Add Selection To. 

Změňte výchozí směr na Clockwise. 

Pro uzavření dialogového okna klikněte na 
Close. 

 
12. Zvolte šedou základovou desku komponenty 

turntable. 

Vytvořte nový 3D Trigger. 
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User Interface: Triggers > Create Flyout> 3D 
Trigger 

 

Pravým tlačítkem myši klikněte na 
vytvořený Trigger1 a zvolte možnost 
Trigger Association > Behaviors > 
Turntable1 > Continue forward. 

 

Zvolte modrou nosnou konstrukci 
komponenty turntable. 

Pomocí možnosti Trigger Association > 
Behaviors > Turntable1 > Pause vytvořte 
druhý spouštěč tak, jak je popsáno výše. 

13. Stiskněte [TAB] k aktivování prezentačního 
režimu. 

Pro zahájení rotace klikněte na šedou 
základovou desku komponenty turntable. 

Otočte model pomocí orbitu. 

Pro zastavení rotace klikněte na modrou 
základní nosnou konstrukci komponenty 
turntable. 

Stiskněte [TAB] k deaktivování 
prezentačního režimu. 

14. Uložte soubor pod názvem 

<FDS-ROOT>\Showcase\Production.a3s. 
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31 Showcase – Materiály a záběry 

1. Otevřete aplikaci Showcase. 

2. Otevřete soubor 

<FDS-ROOT>\Showcase\Production.a3s. 

3. Použitím pohledové kostky změňte 

pohled na Home. 

Zvolte osu otáčení na pravé horní 
dřevěné bedně a přibližte si ji. 

 
4. Zvolte pravou horní dřevěnou bednu.  

Stiskněte klávesu [M] pro zobrazení 
uživatelského rozhraní Materials. 

V poli filtru napište Pine a pro potvrzení 
stiskněte [ENTER]. 

Rozbalte položku Wood pod Showcase 
Materials. 

Pravým tlačítkem myši klikněte na 
materiál Pine-Satin Finish a zvolte 
možnost Assign to Selection. 

 

5. Více si přibližte dřevěnou bednu. Stále 

ještě nelze rozlišit texturu materiálu. 

 

Znovu zvolte dřevěnou bednu a 
stisknutím kombinace kláves [Ctrl]+[M] 
otevřete dialogové okno Material 
Properties. 

Rozbalte sekci Color a nastavte Mapping 
type  na Triplanar. 

Klikněte na tlačítko Autofit a pro každou 
osu zadejte měřítko 5.  

Nastavte rotaci na 90 stupňů ve směru Z. 

 

Pro uzavření dialogového okna klikněte 
na tlačítko Close. 
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6. Zvolte znovu dřevěnou bednu. 

Otevřete funkci Copy Material. 
Menu: Appearance>Copy Material 

 

Stiskněte [ESC] pro ukončení výběru. 

Podržte stisknutou klávesu [SHIFT] a 
vyberte sedm zbývajících dřevěných 
beden. 

 

Otevřete funkci Paste Material. 
Menu: Appearance>Paste Material 

 

Stiskněte [ESC]. 

 
7. Zvolte pravou horní dřevěnou bednu. 

Do pole filtru panelu Materials napište 
Autodesk a stiskněte [ENTER]. 

Rozbalte položku Decals pod Showcase 
Materials. 

Pravým tlačítkem myši klikněte na 
materiál Autodesk Logo Black a zvolte 
možnost Assign to Selection as Decal. 

 
8. Stisknutím kombinace kláves [Ctrl]+[M] 

otevřete dialogové okno Material 

Properties. 

Rozbalte sekci Decals a nastavte Scale na 
5.2, 1.3 a 0.5. 

Nastavte rotaci  90 stupňů ve směru X. 
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Klikněte na tlačítko Move Texture a 
použitím směrových šipek umístěte obtisk 
tak, jak je ukázáno na obrázku dole. 

 
9. Přiřaďte mezipatru materiál Steel Checker 

Plate.  

Pro tento materiál vyberte jako Relief 

properties funkci Autofit a nastavte 

měřítko manuálně.  

 
10. Pravým tlačítkem myši klikněte na 

váleček válečkového dopravníku. 

Pro zvolení všech válečků válečkového 
dopravníku klikněte na možnost All 
objects with this material.  

 

Válečkům přiřaďte materiál Chrome 
Satin. 

Tento material není potřeba upravovat. 

11. Přiřaďte jakékoliv další materiály dle 

vlastního výběru. 

12. Ve spodní části aplikace klikněte na druhý 

symbol zleva pro zobrazení uživatelského 

rozhraní Lighting Environments & 

Background.  

 

Klikněte na prostředí Old Warehouse. 

 
13. Otevřete funkci Scene Settings… 

Menu: File>Settings> Scene Settings… 
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Změňte Size of environments na 0.1, 
Units  na mm a Center coordinates X a Y -
3300 mm a -2800mm. 

Pro potvrzení změn klikněte na OK. 

 

14. Použitím pohledové kostky změňte 

pohled na Top. 

15. Ve spodní části aplikace klikněte na třetí 

symbol zleva pro zobrazení uživatelského 

rozhraní Adjust Lighting. 

 

V okně Brightness level posuňte pro 
zvýšení celkové expozice posuvník lehce 
doprava. 

Klikněte na tlačítko Light. 

Klikněte a přetáhněte světlo do jakékoliv 
pozice přímo v modelu. 

16. Stiskněte klávesu [E] pro zobrazení 

uživatelského rozhraní Environments . 

17. Pravým tlačítkem myši klikněte na 

prostředí Old Warehouse a zvolte 

možnost Properties. 

 

Vyberte podmínky světla Interior: 
Artificial a klikněte na tlačítko Adjust 
Directional Light and Shadows. 
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Srovnejte nastavení s následujícím 
obrázkem. 

 

Pro uzavření dialogových oken klikněte na 
tlačítka Close. 

18. Stiskněte klávesu [T] pro zobrazení 

uživatelského rozhraní Shots. 

Vytvořte nový záběr Start to end.e 
User Interface: Shots >Create 
Flyout>Start to end 

 

Pravým tlačítkem myši klikněte na 
mezipatro. 

V kontextovém menu zvolte možnost 
Mezzanine:1. 

 

Použitím pohledové kostky změňte 
pohled na Home. 

Kliknutím na tlačítko Reset Start nastavte 
aktuální pohled na pohled Home. 

 

Přibližte si oblast robotického systému a 
pravým tlačítkem myši klikněte na 
komponentu turntable. 

V kontextovém menu zvolte možnost 
Turn Table:1. 

Použitím pohledové kostky změňte 
pohled na Home.  

Kliknutím na tlačítko Reset End nastavte 
aktuální pohled jako pohled konečný. 

Potvrďte délku 10 sekund. 

Klikněte na tlačítko Preview. 

 

Vytvořte další záběr Start to end. 
Ujistěte, že pohled Home nového záběru 
odpovídá konečnému pohledu prvního 
záběru. 

Použitím pohledové kostky změňte 
pohled na ISO South-East. 

 

Kliknutím na tlačítko Reset End nastavte 
aktuální pohled jako pohled konečný. 

Potvrďte délku 5 sekund. 

Klikněte na tlačítko Preview. 

19. Pravým tlačítkem klikněte na první záběr. 

Zvolte možnost Save Shot as Movie. 
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20. V oblasti What to Publich zvolte možnost 
All shots (together) a nastavte MPEG-4 
movie (MP4) jako formát výstupu.  

Aktivujte možnost Anti-aliasing s nižší 
intenzitou. 

Vyberte Locally only jako cíl cesty. 

Klikněte na Publish Movie(s)…a uložte 
video pod názvem  

<FDS-ROOT>\Showcase\Production.mp4. 

 
21. Uložte soubor pod názvem 

<FDS-ROOT>\Showcase\Production.a3s. 

Zajímavé odkazy, o kterých byste měli vědět: 

http://labs.autodesk.com/ 

Online zdroj pro FDS: 
http://wikihelp.autodesk.com/Factory_Design
_Suite/enu/2013 
Software Updates pro FDS: 
http://usa.autodesk.com/adsk/servlet/ps/dl/i
ndex?siteID=123112&id=2334435&linkID=156
39656#section1 
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